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Protect SAP HANA databases
SnapCenter Plug-in for SAP HANA Databases

SnapCenter Plug-in for SAP HANA Database overview

The SnapCenter Plug-in for SAP HANA Database is a host-side component of the
NetApp SnapCenter software that enables application-aware data protection
management of SAP HANA databases. The Plug-in for SAP HANA Database automates
the backup, restore, and cloning of SAP HANA databases in your SnapCenter
environment.

SnapCenter supports single container and multitenant database containers (MDC). You can use the Plug-in for
SAP HANA Database in both Windows and Linux environments. The plug-in that is not installed on the HANA
database host is known as the centralized host plug-in. The centralized host plug-in can manage multiple
HANA databases across different hosts.

When the Plug-in for SAP HANA Database is installed, you can use SnapCenter with NetApp SnapMirror
technology to create mirror copies of backup sets on another volume. You can also use the plug-in with NetApp
SnapVault technology to perform disk-to-disk backup replication for standards compliance.

What you can do using the SnapCenter Plug-in for SAP HANA Database

When you install the Plug-in for SAP HANA Database in your environment, you can use
SnapCenter to back up, restore, and clone SAP HANA databases and their resources.
You can also perform tasks supporting those operations.

» Add databases.

* Create backups.

* Restore from backups.

* Clone backups.

» Schedule backup operations.

* Monitor backup, restore, and clone operations.

* View reports for backup, restore, and clone operations.

SnapCenter Plug-in for SAP HANA Database features

SnapCenter integrates with the plug-in application and with NetApp technologies on the
storage system. To work with the Plug-in for SAP HANA Database, you use the
SnapCenter graphical user interface.

* Unified graphical user interface

The SnapCenter interface provides standardization and consistency across plug-ins and environments.
The SnapCenter interface enables you to complete consistent backup, restore, and clone operations
across plug-ins, use centralized reporting, use at-a-glance dashboard views, set up role-based access
control (RBAC), and monitor jobs across all plug-ins.



* Automated central administration
You can schedule backup operations, configure policy-based backup retention, and perform restore
operations. You can also proactively monitor your environment by configuring SnapCenter to send email
alerts.

* Nondisruptive NetApp Snapshot copy technology

SnapCenter uses NetApp Snapshot copy technology with the Plug-in for SAP HANA Database to back up
resources.

Using the Plug-in for SAP HANA Database also offers the following benefits:

» Support for backup, restore, and clone workflows

* RBAC-supported security and centralized role delegation

You can also set the credentials so that the authorized SnapCenter users have application-level
permissions.

 Creation of space-efficient and point-in-time copies of resources for testing or data extraction by using
NetApp FlexClone technology

A FlexClone license is required on the storage system where you want to create the clone.

» Support for the consistency group (CG) Snapshot copy feature of ONTAP as part of creating backups.

» Capability to run multiple backups simultaneously across multiple resource hosts
In a single operation, Snapshot copies are consolidated when resources in a single host share the same
volume.

» Capability to create Snapshot copies using external commands.

» Support for file-based backup.
» Support for Linux LVM on XFS file system.

Storage types supported by SnapCenter Plug-in for SAP HANA Database

SnapCenter supports a wide range of storage types on both physical machines and
virtual machines (VMs). You must verify the support for your storage type before installing
SnapCenter Plug-in for SAP HANA Database.

Machine Storage type

Physical and virtual servers FC-connected LUNs
Physical server iSCSI-connected LUNs
Physical and virtual servers NFS-connected volumes



Minimum ONTAP privileges required for SAP HANA plug-in

The minimum ONTAP privileges that are required vary according to the SnapCenter plug-
ins you are using for data protection.

+ All-access commands: Minimum privileges required for ONTAP 8.3.0 and later
o event generate-autosupport-log
o job history show
° job stop
° lun
o |lun create
o lun create
o lun create
° lun delete
° |lun igroup add
o lun igroup create
o lun igroup delete
° lun igroup rename
° lun igroup rename
o lun igroup show
° lun mapping add-reporting-nodes
° lun mapping create
° lun mapping delete
° lun mapping remove-reporting-nodes
° lun mapping show
° lun modify
° lun move-in-volume
o lun offline
o lun online
° lun persistent-reservation clear
° lun resize
° lun serial
° lun show
o snapmirror policy add-rule
o snapmirror policy modify-rule
o snapmirror policy remove-rule
o snapmirror policy show

o snapmirror restore



snapmirror show
snapmirror show-history
snapmirror update
snapmirror update-Is-set
snapmirror list-destinations
version

volume clone create
volume clone show
volume clone split start
volume clone split stop
volume create

volume destroy

volume file clone create
volume file show-disk-usage
volume offline

volume online

volume modify

volume qgtree create
volume qgtree delete
volume qtree modify
volume qgtree show

volume restrict

volume show

volume snapshot create
volume snapshot delete
volume snapshot modify
volume snapshot rename
volume snapshot restore
volume snapshot restore-file
volume snapshot show
volume unmount

vserver cifs

vserver cifs share create
vserver cifs share delete
vserver cifs shadowcopy show
vserver cifs share show

vserver cifs show



o vserver export-policy
o vserver export-policy create
o vserver export-policy delete
o vserver export-policy rule create
o vserver export-policy rule show
o vserver export-policy show
o vserver iscsi
o vserver iscsi connection show
o vserver show
* Read-only commands: Minimum privileges required for ONTAP 8.3.0 and later
> network interface
> network interface show

° vserver

Prepare storage systems for SnapMirror and SnapVault replication for SAP HANA
databases

You can use a SnapCenter plug-in with ONTAP SnapMirror technology to create mirror
copies of backup sets on another volume, and with ONTAP SnapVault technology to
perform disk-to-disk backup replication for standards compliance and other governance-
related purposes. Before you perform these tasks, you must configure a data-protection
relationship between the source and destination volumes and initialize the relationship.

SnapCenter performs the updates to SnapMirror and SnapVault after it completes the Snapshot copy

operation. SnapMirror and SnapVault updates are performed as part of the SnapCenter job; do not create a
separate ONTAP schedule.

@ If you are coming to SnapCenter from a NetApp SnapManager product and are satisfied with the
data protection relationships you have configured, you can skip this section.

A data protection relationship replicates data on primary storage (the source volume) to secondary storage (the
destination volume). When you initialize the relationship, ONTAP transfers the data blocks referenced on the
source volume to the destination volume.

@ SnapCenter does not support cascade relationships between SnapMirror and SnapVault
volumes (Primary > Mirror > Vault). You should use fanout relationships.

SnapCenter supports the management of version-flexible SnapMirror relationships. For details about version-
flexible SnapMirror relationships and how to set them up, see the ONTAP documentation.

@ SnapCenter does not support sync_mirror replication.

Backup strategy for SAP HANA databases
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Define a backup strategy for SAP HANA databases

Defining a backup strategy before you create your backup jobs helps you to have the
backups that you require to successfully restore or clone your resources. Your service-
level agreement (SLA), recovery time objective (RTO), and recovery point objective
(RPO) largely determine your backup strategy.

About this task

An SLA defines the level of service that is expected and addresses many service-related issues, including the
availability and performance of the service. RTO is the time by which a business process must be restored
after a disruption in service. RPO defines the strategy for the age of the files that must be recovered from
backup storage for regular operations to resume after a failure. SLA, RTO, and RPO contribute to the data
protection strategy.

Steps
1. Determine when you should back up your resources.
2. Decide how many backup jobs you require.
3. Decide how to name your backups.

4. Decide whether you want to create a Snapshot copy-based policy to back up application-consistent
Snapshot copies of the database.

5. Decide whether you want to verify the integrity of the database.

6. Decide whether you want to use NetApp SnapMirror technology for replication or NetApp SnapVault
technology for long-term retention.

7. Determine the retention period for the Snapshot copies on the source storage system and the SnapMirror
destination.

8. Determine whether you want to run any commands before or after the backup operation and provide a
prescript or postscript.

Automatic discovery of resources on Linux host

Resources are SAP HANA databases and Non-data Volume on the Linux host that are
managed by SnapCenter. After installing the SnapCenter Plug-in for SAP HANA
Database plug-in, the SAP HANA databases on that Linux host are automatically
discovered and displayed in the Resources page.

Automatic discovery is supported for the following SAP HANA resources:
 Single containers

After installing or upgrading the plug-in, the single container resources located on a centralized host plug-in
will continue as manually added resources.

After installing or upgrading the plug-in, the SAP HANA databases are automatically discovered only on the
SAP HANA Linux hosts, which are directly registered into SnapCenter.

» Multitenant database container (MDC)

After installing or upgrading the plug-in, the MDC resources located on a centralized host plug-in will
continue as manually added resource.



You must continue to manually add the MDC resources on the centralized host plug-in after upgrading to
SnapCenter 4.3.

For SAP HANA Linux hosts directly registered in SnapCenter, installing or upgrading the plug-in will trigger
an automatic discovery for resources on the host. After upgrading the plug-in, for every MDC resource that
was located on the plug-in host, another MDC resource will be automatically discovered with a different
GUID format and registered in SnapCenter. The new resource will be in locked state.

For example, in SnapCenter 4.2, if E90 MDC resource was located on the plug-in host and registered

manually, after upgrading to SnapCenter 4.3, another E90 MDC resource with a different GUID will be
discovered and registered in SnapCenter.

Automatic discovery is not supported for the following configurations:

RDM and VMDK layouts

@ In case the above resources are discovered, the data protection operations are not
supported on these resources.

HANA multiple-host configuration

Multiple instances on the same host

Multitier scale out HANA System Replication

Cascaded replication environment in System Replication mode

Type of backups supported

Backup type specifies the type of backup that you want to create. SnapCenter supports
File-Based Backup and Snapshot copy-based backup types for SAP HANA databases.

File-Based Backup

File-Based Backups verify the integrity of the database. You can schedule the file-based backup operation to
occur at specific intervals. Only active tenants are backed up. You cannot restore and clone File-Based
backups from SnapCenter.

Snapshot copy based backup

Snapshot copy-based backups leverage NetApp Snapshot copy technology to create online, read-only copies
of the volumes on which the SAP HANA databases reside.

How SnapCenter Plug-in for SAP HANA Database uses consistency group Snapshot copies

You can use the plug-in to create consistency group Snapshot copies for resource
groups. A consistency group is a container that can house multiple volumes so that you
can manage them as one entity. A consistency group is simultaneous Snapshot copies of
multiple volumes, providing consistent copies of a group of volumes.

You can also specify the wait time for the storage controller to consistently group Snapshot copies. The
available wait time options are Urgent, Medium, and Relaxed. You can also enable or disable Write Anywhere
File Layout (WAFL) sync during consistent group Snapshot copy operation. WAFL sync improves the
performance of a consistency group Snapshot copy.



How SnapCenter manages housekeeping of log and data backups

SnapCenter manages the housekeeping of log and data backups on the storage system
and file system levels, and within the SAP HANA backup catalog.

The Snapshot copies on the primary or secondary storage and their corresponding entries in the SAP HANA

catalog are deleted based on the retention settings. The SAP HANA catalog entries are also deleted during
backup and resource group deletion.

Considerations for determining backup schedules for SAP HANA database

The most critical factor in determining a backup schedule is the rate of change for the
resource. You might back up a heavily used resource every hour, while you might back up
a rarely used resource once a day. Other factors include the importance of the resource
to your organization, your service-level agreement (SLA) and your recovery point
objective (RPO).

Backup schedules have two parts, as follows:
» Backup frequency (how often backups are to be performed)

Backup frequency, also called schedule type for some plug-ins, is part of a policy configuration. For
example, you might configure the backup frequency as hourly, daily, weekly, or monthly.

* Backup schedules (exactly when backups are to be performed
Backup schedules are part of a resource or resource group configuration. For example, if you have a

resource group that has a policy configured for weekly backups, you might configure the schedule to back
up every Thursday at 10:00 p.m.

Number of backup jobs needed for SAP HANA databases

Factors that determine the number of backup jobs that you need include the size of the
resource, the number of volumes used, the rate of change of the resource, and your
Service Level Agreement (SLA).

Backup naming conventions for Plug-in for SAP HANA databases

You can either use the default Snapshot copy naming convention or use a customized
naming convention. The default backup naming convention adds a timestamp to
Snapshot copy names that helps you identify when the copies were created.

The Snapshot copy uses the following default naming convention:
resourcegroupname hostname timestamp

You should name your backup resource groups logically, as in the following example:

dtsl machlx88 03-12-2015 23.17.26



In this example, the syntax elements have the following meanings:

* dts1is the resource group name.
* mach1x88 is the host name.
* 03-12-2015_23.17.26 is the date and timestamp.

Alternatively, you can specify the Snapshot copy name format while protecting resources or resource groups
by selecting Use custom name format for Snapshot copy. For example,
customtext_resourcegroup_policy _hostname or resourcegroup_hostname. By default, the time stamp suffix is
added to the Snapshot copy name.

Restore and recovery strategy for SAP HANA databases

Define a restore and recovery strategy for SAP HANA resources

You must define a strategy before you restore and recover your database so that you can
perform restore and recovery operations successfully.

Steps
1. Determine the restore strategies supported for manually added SAP HANA resources

2. Determine the restore strategies supported for auto discovered SAP HANA databases

3. Decide the type of recovery operations that you want to perform.

Types of restore strategies supported for manually added SAP HANA resources

You must define a strategy before you can successfully perform restore operations using
SnapCenter. There are two types of restore strategies for manually added SAP HANA
resources. You cannot recover manually added SAP HANA resources.

@ You cannot recover manually added SAP HANA resources.

Complete resource restore

* Restores all volumes, qgtrees, and LUNs of a resource

If the resource contains volumes or gtrees, the Snapshot copies taken after the Snapshot copy
@ selected for restore on such volumes or gtrees are deleted and cannot be recovered. Also, if any
other resource is hosted on the same volumes or gtrees, then that resource is also deleted.

File level restore

* Restores files from volumes, qtrees, or directories

* Restores only the selected LUNs

Types of restore strategies supported for automatically discovered SAP HANA databases

You must define a strategy before you can successfully perform restore operations using
SnapCenter. There are two types of restore strategies for automatically discovered SAP
HANA databases.



Complete resource restore

» Restores all volumes, gtrees, and LUNs of a resource

o The Volume Revert option should be selected to restore the entire volume.

If the resource contains volumes or gtrees, the Snapshot copies taken after the

@ Snapshot copy selected for restore on such volumes or gtrees are deleted and cannot
be recovered. Also, if any other resource is hosted on the same volumes or gtrees, then
that resource is also deleted.

Tenant Database

* Restores the tenant database

If Tenant Database option is selected, then HANA studio or HANA recovery scripts external to SnapCenter
must be used to perform the recovery operation.

Types of restore operations for auto discovered SAP HANA databases

SnapCenter supports volume-based SnapRestore (VBSR), Single File SnapRestore, and
connect-and-copy restore types for automatically discovered SAP HANA databases.

Volume-based SnapRestore (VBSR) is performed in NFS environments for the following scenarios:
* When the backup selected for restore is taken on releases earlier than SnapCenter 4.3, and only if the
Complete Resourceoption is selected

* When the backup selected for restore is taken in SnapCenter 4.3, and if the Volume Revert option is
selected

Single File SnapRestore is performed in NFS environments for the following scenarios:

* When the backup selected for restore is taken in SnapCenter 4.3, and if only the Complete Resource
option is selected

» For multitenant database containers (MDC), when the backup selected for restore is taken on SnapCenter
4.3, and the Tenant Database option is selected

* When the backup selected is from a SnapMirror or SnapVault secondary location, and the Complete
Resource option is selected

Single File SnapRestore is performed in SAN environments for the following scenarios:

* When backups are taken on releases earlier than SnapCenter 4.3, and only if the Complete Resource
option is selected

» When backups are taken in SnapCenter 4.3, and only if the Complete Resource option is selected
* When the backup is selected from a SnapMirror or SnapVault secondary location, and the Complete
Resource option is selected

Connect-and-copy based restore is performed in SAN environments for the following scenario:

* For MDC, when the backup selected for restore is taken in SnapCenter 4.3, and the Tenant Database
option is selected
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@ Complete Resource, Volume Revert, and Tenant Database options are available on the
Restore Scope page.

Types of recovery operations supported for SAP HANA databases

SnapCenter enables you to perform different types of recovery operations for SAP HANA
databases.

* Recover the database up to the most recent state

» Recover the database up to a specific point in time
You must specify the date and time for recovery.
* Recover the database up to a specific data backup

SnapCenter also provides the No recovery option for SAP HANA databases.

Prepare to install the SnapCenter Plug-in for SAP HANA
Database

Installation workflow of SnapCenter Plug-in for SAP HANA Database

You should install and set up the SnapCenter Plug-in for SAP HANA Database if you
want to protect SAP HANA databases.

| Lag in to the SnapCenter Server using a web browser. |

-

| Idmnitify storage types supported, |

v

Review installation prerequisites and
install plug-in package for Linux or Windaws.

v

Set up credentials.

v

Install and configure the plug-ins

v

Add databases and assign them to users.

v

Configure and enable CA Certificate.

Prerequisites for adding hosts and installing SnapCenter Plug-in for SAP HANA
Database

Before you add a host and install the plug-in packages, you must complete all the
requirements. SnapCenter Plug-in for SAP HANA Database is available in both Windows
and Linux environments.

11



* You must have installed Java 1.8 64-bit on your host.
@ IBM Java is not supported.

* You must have installed SAP HANA database interactive terminal (HDBSQL client) on the host.

» For Windows, plug-in Creator Service should be running using the “LocalSystem” windows user, which is
the default behavior when Plug-in for SAP HANA Database is installed as domain administrator.

» For Windows, user store keys should be created as SYSTEM user.

* When installing a plug-in on a Windows host, if you specify a credential that is not built-in or if the user
belongs to a local workgroup user, you must disable UAC on the host. SnapCenter Plug-in for Microsoft
Windows will be deployed by default with the SAP HANA plug-in on Windows hosts.

* For Linux host, HDB Secure User Store keys are accessed as HDBSQL OS user.

» SnapCenter Server should have access to the 8145 or custom port of Plug-in for SAP HANA Database
host.

Windows hosts

* You must have a domain user with local administrator privileges with local login permissions on the remote
host.

* While installing Plug-in for SAP HANA Database on a Windows host, SnapCenter Plug-in for Microsoft
Windows is installed automatically.

* You must have enabled the password-based SSH connection for the root or non-root user.

* You must have installed Java 1.8 64-bit on your Windows host.
Java Downloads for All Operating Systems

NetApp Interoperability Matrix Tool

Linux hosts

* You must have enabled the password-based SSH connection for the root or non-root user.

* You must have installed Java 1.8 64-bit on your Linux host.
Java Downloads for All Operating Systems
NetApp Interoperability Matrix Tool

» For SAP HANA databases that are running on a Linux host, while installing Plug-in for SAP HANA
Database, SnapCenter Plug-in for UNIX is installed automatically.

* You should have bash as the default shell for plug-in installation.

Supplemental commands

To run a supplemental command on the SnapCenter Plug-in for SAP HANA, you must include it in the
allowed commands.config file.

allowed commands.config file is located in the "etc" subdirectory of the SnapCenter Plug-in for SAP
HANA directory.
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Windows hosts

Default: C: \Program Files\NetApp\SnapCenter\HANA\etc\allowed commands.config

Custom path: <Custome Directory>\NetApp\SnapCenter\HANA\etc\allowed commands.config
Windows host:

Linux hosts

Default: /opt/NetApp/snapcenter/scc/etc/allowed commands.config
Custom path: <Custome Directory>/NetApp/snapcenter/scc/etc/allowed commands.config

To allow supplemental commands on the plug-in host, open allowed commands.config file in an editor.
Enter each command on a separate line. It is not case sensitive. For example,

command: mount
command: umount

Ensure that you specify the fully qualified pathname. Enclose the pathname in quotation marks (") if it contains
spaces. For example,

command: "C:\Program Files\NetApp\SnapCreator commands\sdcli.exe"
command: myscript.bat

If the allowed commands.config file is not present, the commands or script execution will be blocked and
the workflow will fail with the following error:

"[/mnt/mount -a] execution not allowed. Authorize by adding the command in the file %s on the plugin host."

If the command or script is not present in the allowed commands.config, the command or script execution
will be blocked and the workflow will fail with the following error:

"[/mnt/mount -a] execution not allowed. Authorize by adding the command in the file %s on the plugin host."

@ You should not use a wildcard entry (*) to allow all commands.

Host requirements to install SnapCenter Plug-ins Package for Windows

Before you install the SnapCenter Plug-ins Package for Windows, you should be familiar
with some basic host system space requirements and sizing requirements.

Item Requirements

Operating Systems Microsoft Windows

For the latest information about supported versions,
see the NetApp Interoperability Matrix Tool.

Minimum RAM for the SnapCenter plug-in on host 1GB

13
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Item Requirements
Minimum install and log space for the SnapCenter 5GB
plug-in on host

You should allocate sufficient disk
space and monitor the storage
consumption by the logs folder. The log
space required varies depending on

@ the number of the entities to be
protected and the frequency of data
protection operations. If there is no
sufficient disk space, the logs will not
be created for the recently run
operations.

Required software packages * Microsoft .NET Framework 4.7.2 or later

* Windows Management Framework (WMF) 4.0 or
later

* PowerShell 4.0 or later

For the latest information about supported versions,
see the NetApp Interoperability Matrix Tool.

For .NET specific troubleshooting information, see

SnapCenter upgrade or install fails for legacy systems
that do not have internet connectivity.

Host requirements for installing the SnapCenter Plug-ins Package for Linux

Before you install the SnapCenter Plug-ins Package for Linux, you should be familiar with
some basic host system space and sizing requirements.

Item Requirements
Operating systems * Red Hat Enterprise Linux

» SUSE Linux Enterprise Server (SLES)

For the latest information about supported versions,
see the NetApp Interoperability Matrix Tool.

Minimum RAM for the SnapCenter plug-in on host 1GB
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Item Requirements
Minimum install and log space for the SnapCenter 2 GB
plug-in on host

You should allocate sufficient disk
space and monitor the storage
consumption by the logs folder. The log
space required varies, depending on

@ the number of the entities to be
protected and the frequency of data
protection operations. If there is no
sufficient disk space, the logs will not
be created for the recently run
operations.

Required software packages Java 1.8.x (64-bit)Oracle Java and OpenJDK flavors
If you have upgraded JAVA to the latest version, you
must ensure that the JAVA_HOME option located at
Ivar/opt/snapcenter/spl/etc/spl.properties is set to the
correct JAVA version and the correct path.

For the latest information about supported versions,
see the NetApp Interoperability Matrix Tool.

Set up credentials for the SnapCenter Plug-in for SAP HANA Database

SnapCenter uses credentials to authenticate users for SnapCenter operations. You
should create credentials for installing SnapCenter plug-ins and additional credentials for
performing data protection operations on databases or Windows file systems.

About this task
e Linux hosts

You must set up credentials for installing plug-ins on Linux hosts.

You must set up the credentials for the root user or for a non-root user who has sudo privileges to install
and start the plug-in process.

Best Practice: Although you are allowed to create credentials for Linux after deploying hosts and
installing plug-ins, the best practice is to create credentials after you add SVMs, before you deploy hosts
and install plug-ins.

* Windows hosts
You must set up Windows credentials before installing plug-ins.

You must set up the credentials with administrator privileges, including administrator rights on the remote
host.

If you set up credentials for individual resource groups and the username does not have full admin privileges,
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you must assign at least the resource group and backup privileges to the username.

Steps
1. In the left navigation pane, click Settings.
2. In the Settings page, click Credential.
3. Click New.

Credential

Provide information for the Credential you want to add

Credential Mame Mame
Username Username
Password Password
Authentication Linux

Use sudo privileges €@

4. In the Credential page, specify the information required for configuring credentials:

For this field...

Credential name

16

Do this...

Enter a name for the credentials.




For this field...

User name

Password

Authentication Mode

Use sudo privileges

5. Click OK.

Do this...

Enter the user name and password that are to be
used for authentication.

* Domain administrator or any member of the

administrator group

Specify the domain administrator or any
member of the administrator group on the
system on which you are installing the
SnapCenter plug-in. Valid formats for the
Username field are:

o NetBIOS\UserName
o Domain FQDN\UserName

Local administrator (for workgroups only)

For systems that belong to a workgroup, specify
the built-in local administrator on the system on
which you are installing the SnapCenter plug-in.
You can specify a local user account that
belongs to the local administrators group if the
user account has elevated privileges or the User
Access control feature is disabled on the host
system. The valid format for the Username field
is: UserName

Do not use double quotes (") or backtick (*) in
the passwords. You should not use the less
than (<) and exclamation (!) symbols together in
passwords. For example, lessthan<!10,
lessthan10<!, backtick™12.

Enter the password used for authentication.

Select the authentication mode that you want to

Select the Use sudo privileges check box if you
are creating credentials for a non-root user.

@ Applicable to Linux users only.

After you finish setting up the credentials, you might want to assign credential maintenance to a user or group

of users in the User and Access page.
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Configure gMSA on Windows Server 2012 or later

Windows Server 2012 or later enables you to create a group Managed Service Account
(gMSA) that provides automated service account password management from a
managed domain account.

Before you begin
* You should have a Windows Server 2012 or later domain controller.

* You should have a Windows Server 2012 or later host, which is a member of the domain.

Steps
1. Create a KDS root key to generate unique passwords for each object in your gMSA.

2. For each domain, run the following command from the Windows domain controller: Add-KDSRootKey
-Effectivelmmediately

3. Create and configure your gMSA:

a. Create a user group account in the following format:
domainName\accountName$

b. Add computer objects to the group.

c. Use the user group you just created to create the gMSA.

For example,

New-ADServiceAccount -name <ServiceAccountName> -DNSHostName <fgdn>
-PrincipalsAllowedToRetrieveManagedPassword <group>
-ServicePrincipalNames <SPN1, SPNZ2,..>

d. Run Get-ADServiceAccount command to verify the service account.
4. Configure the gMSA on your hosts:

a. Enable the Active Directory module for Windows PowerShell on the host where you want to use the
gMSA account.

To do this, run the following command from PowerShell:
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PS C:\> Get-WindowsFeature AD-Domain-Services

Display Name Name Install
State

[ ] Active Directory Domain Services AD-Domain-Services Available

PS C:\> Install-WindowsFeature AD-DOMAIN-SERVICES

Success Restart Needed Exit Code Feature Result

True No Success {Active Directory Domain
Services, Active

WARNING: Windows automatic updating is not enabled. To ensure that
your newly-installed role or feature 1is

automatically updated, turn on Windows Update.

b. Restart your host.

c. Install the gMSA on your host by running the following command from the PowerShell command
prompt: Install-AdServiceAccount <gMSA>

d. Verify your gMSA account by running the following command: Test-AdServiceAccount <gMSA>

5. Assign the administrative privileges to the configured gMSA on the host.
6. Add the Windows host by specifying the configured gMSA account in the SnapCenter Server.

SnapCenter Server will install the selected plug-ins on the host and the specified gMSA will be used as the
service log on account during the plug-in installation.

Install the SnapCenter Plug-in for SAP HANA Databases

Add hosts and install plug-in packages on remote hosts

You must use the SnapCenter Add Host page to add hosts, and then install the plug-ins
packages. The plug-ins are automatically installed on the remote hosts. You can add a
host and install plug-in packages either for an individual host or for a cluster.

Before you begin

* You must be a user that is assigned to a role that has the plug-in install and uninstall permissions, such as
the SnapCenter Admin role.

* When installing a plug-in on a Windows host, if you specify a credential that is not built-in, or if the user
belongs to a local workgroup user, you must disable UAC on the host.

* You should ensure that the message queueing service is running.

* The administration documentation contains information about managing hosts.
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« If you are using group Managed Service Account (gMSA), you should configure gMSA with administrative
privileges.

Configure group Managed Service Account on Windows Server 2012 or later for SAP HANA

About this task
* You cannot add a SnapCenter Server as a plug-in host to another SnapCenter Server.
* For SAP HANA System Replication to discover resources on both primary and secondary systems, it is
recommended to add both the primary and the secondary systems using root or sudo user.
Steps
1. In the left navigation pane, click Hosts.
2. Verify that the Managed Hosts tab is selected at the top.
3. Click Add.

4. In the Hosts page, perform the following actions:

For this field... Do this...

Host Type Select the type of host:
* Windows
* Linux

The Plug-in for SAP HANA is
installed on the HDBSQL client

@ host, and this host can be on
either a Windows system or a
Linux system.

Host name Enter the communication host name. Enter the fully
qualified domain name (FQDN) or the IP address of
the host. SnapCenter depends on the proper
configuration of the DNS. Therefore, the best
practice is to enter the FQDN.

You must configure the HDBSQL client and
HDBUserStore on this host.
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For this field...

Credentials

Do this...

Either select the credential name that you created
or create new credentials. The credential must have
administrative rights on the remote host. For details,
see the information about creating credentials.

You can view details about the credentials by
positioning your cursor over the credential name
that you provided.

The credentials authentication mode
is determined by the host type that
you specify in the Add Host wizard.

5. In the Select Plug-ins to Install section, select the plug-ins to install.

6. (Optional) Click More Options.

For this field...
Port

Installation Path

Skip preinstall checks

Do this...

Either retain the default port number or specify the
port number. The default port number is 8145. If the
SnapCenter Server was installed on a custom port,
that port number will be displayed as the default
port.

If you manually installed the plug-ins
@ and specified a custom port, you

must specify the same port.

Otherwise, the operation fails.

The Plug-in for SAP HANA is installed on the
HDBSAQL client host, and this host can be on either
a Windows system or a Linux system.

* For the SnapCenter Plug-ins Package for
Windows, the default path is C:\Program
Files\NetApp\SnapCenter. Optionally, you can
customize the path.

* For the SnapCenter Plug-ins Package for Linux,
the default path is /opt/NetApp/snapcenter.
Optionally, you can customize the path.

Select this check box if you already installed the
plug-ins manually and you do not want to validate
whether the host meets the requirements for
installing the plug-in.
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For this field... Do this...

Use group Managed Service Account (gMSA) to run  For Windows host, select this check box if you want
the plug-in services to use group Managed Service Account (QMSA) to
run the plug-in services.

Provide the gMSA name in the

@ following format:

domainName\accountName$.

gMSA will be used as a log on
@ service account only for SnapCenter
Plug-in for Windows service.

7. Click Submit.
If you have not selected the Skip prechecks checkbox, the host is validated to verify whether the host
meets the requirements for installing the plug-in. The disk space, RAM, PowerShell version, .NET version,
location (for Windows plug-ins), and Java version (for Linux plug-ins) are validated against the minimum
requirements. If the minimum requirements are not met, appropriate error or warning messages are
displayed.
If the error is related to disk space or RAM, you can update the web.config file located at C:\Program

Files\NetApp\SnapCenter WebApp to modify the default values. If the error is related to other parameters,
you must fix the issue.

@ In an HA setup, if you are updating web.config file, you must update the file on both nodes.

8. If host type is Linux, verify the fingerprint, and then click Confirm and Submit.

In a cluster setup, you should verify the fingerprint of each of the nodes in the cluster.

@ Fingerprint verification is mandatory even if the same host was added earlier to SnapCenter
and the fingerprint was confirmed.

9. Monitor the installation progress.

The installation-specific log files are located at /custom_location/snapcenter/logs.

Install SnapCenter Plug-in Packages for Linux or Windows on multiple remote hosts by using cmdlets

You can install the SnapCenter Plug-in Packages for Linux or Windows on multiple hosts
simultaneously by using the Install-SmHostPackage PowerShell cmdlet.

Before you begin

You must have logged in to SnapCenter as a domain user with local administrator rights on each host on which
you want to install the plug-in package.

Steps
1. Launch PowerShell.
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2. On the SnapCenter Server host, establish a session using the Open-SmConnection cmdlet, and then enter
your credentials.

3. Install the plug-in on multiple hosts using the Install-SmHostPackage cmdlet and the required parameters.
The information regarding the parameters that can be used with the cmdlet and their descriptions can be

obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter
Software Cmdlet Reference Guide.

You can use the -skipprecheck option when you have installed the plug-ins manually and do not want to
validate whether the host meets the requirements to install the plug-in.

4. Enter your credentials for remote installation.

Install the SnapCenter Plug-in for SAP HANA Database on Linux hosts by using the command-line
interface

You should install the SnapCenter Plug-in for SAP HANA Database by using the
SnapCenter user interface (Ul). If your environment does not allow remote installation of
the plug-in from the SnapCenter Ul, you can install the Plug-in for SAP HANA Database
either in console mode or in silent mode by using the command-line interface (CLI).

Before you begin

* You should install the Plug-in for SAP HANA Database on each of the Linux host where the HDBSQL client
resides.

* The Linux host on which you are installing the SnapCenter Plug-in for SAP HANA Database must meet the
dependent software, database, and operating system requirements.
The Interoperability Matrix Tool (IMT) contains the latest information about the supported configurations.

NetApp Interoperability Matrix Tool

* The SnapCenter Plug-in for SAP HANA Database is part of SnapCenter Plug-ins Package for Linux.
Before you install SnapCenter Plug-ins Package for Linux, you should have already installed SnapCenter
on a Windows host.

Steps

1. Copy the SnapCenter Plug-ins Package for Linux installation file (snapcenter_linux_host_plugin.bin) from
C:\ProgramData\NetApp\SnapCenter\Package Repository to the host where you want to install the Plug-in
for SAP HANA Database.

You can access this path from the host where the SnapCenter Server is installed.

2. From the command prompt, navigate to the directory where you copied the installation file.

3. Install the plug-in: path to_installation bin file/snapcenter linux host plugin.bin -i
silent -DPORT=port number for host -DSERVER IP=server name or ip address
-DSERVER HTTPS PORT=port number for server

o -DPORT specifies the SMCore HTTPS communication port.
o -DSERVER_IP specifies the SnapCenter Server IP address.
o -DSERVER_HTTPS_PORT specifies the SnapCenter Server HTTPS port.
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o -DUSER_INSTALL_DIR specifies the directory where you want to install the SnapCenter Plug-ins
Package for Linux.

o DINSTALL_LOG_NAME specifies the name of the log file.

/tmp/sc-plugin-installer/snapcenter linux host plugin.bin -i silent
-DPORT=8145 -DSERVER IP=scserver.domain.com -DSERVER HTTPS PORT=8146
-DUSER_INSTALL DIR=/opt

-DINSTALL LOG NAME=SnapCenter Linux Host Plugin Install 2.log
-DCHOSEN FEATURE LIST=CUSTOM

4. Edit the /<installation directory>/NetApp/snapcenter/scc/etc/SC_SMS_Services.properties file, and then
add the PLUGINS_ENABLED = hana:3.0 parameter.

5. Add the host to the SnapCenter Server using the Add-Smhost cmdlet and the required parameters.

The information regarding the parameters that can be used with the command and their descriptions can
be obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter
Software Cmdlet Reference Guide.

Monitor the status of installing Plug-in for SAP HANA

You can monitor the progress of SnapCenter plug-in package installation by using the
Jobs page. You might want to check the progress of installation to determine when it is
complete or if there is an issue.

About this task
The following icons appear on the Jobs page and indicate the state of the operation:

In progress
. Completed successfully
« x Failed

Completed with warnings or could not start due to warnings
* D Queued

Steps
1. In the left navigation pane, click Monitor.

2. In the Monitor page, click Jobs.
3. In the Jobs page, to filter the list so that only plug-in installation operations are listed, do the following:
a. Click Filter.
b. Optional: Specify the start and end date.
c. From the Type drop-down menu, select Plug-in installation.
d. From the Status drop-down menu, select the installation status.
. Click Apply.

]

4. Select the installation job and click Details to view the job details.
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5. In the Job Details page, click View logs.

Configure CA Certificate

Generate CA Certificate CSR file

You can generate a Certificate Signing Request (CSR) and import the certificate that can
be obtained from a Certificate Authority (CA) using the generated CSR. The certificate will
have a private key associated with it.

CSR is a block of encoded text that is given to an authorized certificate vendor to procure the signed CA
certificate.

(i)  CACertificate RSAkey length should be minimum 3072 bits.
For information to generate a CSR, see How to generate CA Certificate CSR file.

If you own the CA certificate for your domain (*.domain.company.com) or your system
(machine1.domain.company.com), you can skip generating the CA Certificate CSR file. You can
deploy the existing CA certificate with SnapCenter.

For cluster configurations, the cluster name (virtual cluster FQDN), and the respective host names should be
mentioned in the CA certificate. The certificate can be updated by filling the Subject Alternative Name (SAN)
field before procuring the certificate. For a wild card certificate (*.domain.company.com), the certificate will
contain all the hostnames of the domain implicitly.

Import CA certificates

You must import the CA certificates to the SnapCenter Server and the Windows host
plug-ins using the Microsoft management console (MMC).

Steps
1. Go to the Microsoft management console (MMC), and then click File > Add/Remove Snapin.

2. In the Add or Remove Snap-ins window, select Certificates and then click Add.
3. In the Certificates snap-in window, select the Computer account option, and then click Finish.

4. Click Console Root > Certificates — Local Computer > Trusted Root Certification Authorities >
Certificates.

5. Right-click on the folder “Trusted Root Certification Authorities”, and then select All Tasks > Import to start
the import wizard.

6. Complete the wizard, as follows:

In this wizard window... Do the following...

Import Private Key Select the option Yes, import the private key, and
then click Next.

Import File Format Make no changes; click Next.
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In this wizard window... Do the following...

Security Specify the new password to be used for the
exported certificate, and then click Next.

Completing the Certificate Import Wizard Review the summary, and then click Finish to start
the import.

@ Importing certificate should be bundled with the private key (supported formats are: *.pfx,
*.p12, and *.p7b).

7. Repeat Step 5 for the “Personal” folder.

Get the CA certificate thumbprint

A certificate thumbprint is a hexadecimal string that identifies a certificate. A thumbprint is
calculated from the content of the certificate using a thumbprint algorithm.

Steps
1. Perform the following on the GUI:

a. Double-click the certificate.

b. In the Certificate dialog box, click the Details tab.

c. Scroll through the list of fields and click Thumbprint.
d. Copy the hexadecimal characters from the box.

e. Remove the spaces between the hexadecimal numbers.

For example, if the thumbprint is: "a9 09 50 2d d8 2a e4 14 33 e6 f8 38 86 b0 0d 42 77 a3 2a 7b", after
removing the spaces, it will be: "a909502dd82ae41433e6f83886b00d4277a32a7b".

2. Perform the following from PowerShell:

a. Run the following command to list the thumbprint of the installed certificate and identify the recently
installed certificate by the subject name.

Get-Childltem -Path Cert:\LocalMachine\My

b. Copy the thumbprint.

Configure CA certificate with Windows host plug-in services

You should configure the CA certificate with Windows host plug-in services to activate the
installed digital certificate.

Perform the following steps on the SnapCenter Server and all the plug-in hosts where CA certificates are
already deployed.

Steps
1. Remove the existing certificate binding with SMCore default port 8145, by running the following command:

> netsh http delete sslcert ipport=0.0.0.0: <SMCore Port>
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For example:

> netsh http delete sslcert ipport=0.0.0.0:8145

2. Bind the newly installed certificate with the Windows host plug-in services, by running the following
commands:

> Scert = “ <certificate thumbprint> ”

> Sguid = [guid]::NewGuid () .ToString ("B")

> netsh http add sslcert ipport=0.0.0.0: <SMCore Port> certhash=Scert
appid="$guid"

For example:

> Scert “a909502dd82ae41433e6£83886b00d4277a32a7b”

> Sguid = [guid]::NewGuid () .ToString ("B")

> netsh http add sslcert ipport=0.0.0.0: <SMCore Port> certhash=Scert
appid="$guid"

Configure the CA Certificate for the SnapCenter SAP HANA Plug-ins service on Linux host

You should manage the password of the custom plug-ins keystore and its certificate,
configure the CA certificate, configure root or intermediate certificates to the custom plug-
ins trust-store, and configure CA signed key pair to custom plug-ins trust-store with
SnapCenter Custom Plug-ins service to activate the installed digital certificate.

Custom plug-ins uses the file 'keystore.jks', which is located at /opt/NetApp/snapcenter/scc/etc both as its trust-
store and key-store.

Manage password for custom plug-in keystore and alias of the CA signed key pair in use

Steps
1. You can retrieve custom plug-in keystore default password from custom plug-in agent property file.

It is the value corresponding to the key 'KEYSTORE_PASS'.

2. Change the keystore password:
keytool -storepasswd -keystore keystore.jks

3. Change the password for all aliases of private key entries in the keystore to the same password used for
the keystore:
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keytool -keypasswd -alias "alias name in cert" -keystore keystore.jks

Update the same for the key KEYSTORE_PASS in agent.properties file.

4. Restart the service after changing the password.

@ Password for custom plug-in keystore and for all the associated alias password of the private
key should be same.

Configure root or intermediate certificates to custom plug-in trust-store

You should configure the root or intermediate certificates without the private key to custom plug-in trust-store.

Steps
1. Navigate to the folder containing the custom plug-in keystore: /opt/NetApp/snapcenter/sccl/etc.
2. Locate the file 'keystore.jks'.

3. List the added certificates in the keystore:
keytool -list -v -keystore keystore.jks
4. Add a root or intermediate certificate:

keytool -import -trustcacerts -alias myRootCA -file
/root/USERTrustRSA Root.cer -keystore keystore.jks

5. Restart the service after configuring the root or intermediate certificates to custom plug-in trust-store.

@ You should add the root CA certificate and then the intermediate CA certificates.

Configure CA signed key pair to custom plug-in trust-store

You should configure the CA signed key pair to the custom plug-in trust-store.

Steps
1. Navigate to the folder containing the custom plug-in keystore /opt/NetApp/snapcenter/scc/etc.
2. Locate the file 'keystore.jks'.

3. List the added certificates in the keystore:
keytool -list -v -keystore keystore.jks
4. Add the CA certificate having both private and public key.

keytool -importkeystore -srckeystore /root/snapcenter.ssl.test.netapp.com.pfx
-srcstoretype pkcsl2 -destkeystore keystore.jks -deststoretype JKS

5. List the added certificates in the keystore.
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10.

keytool -list -v -keystore keystore.jks

. Verify that the keystore contains the alias corresponding to the new CA certificate, which was added to the

keystore.

. Change the added private key password for CA certificate to the keystore password.

Default custom plug-in keystore password is the value of the key KEYSTORE_PASS in agent.properties
file.

keytool -keypasswd -alias "alias name in CA cert" -keystore keystore.jks

. If the alias name in the CA certificate is long and contains space or special characters ("*",","), change the

alias name to a simple name:

keytool -changealias -alias "long alias name" -destalias "simple alias"
-keystore keystore.jks

. Configure the alias name from CA certificate in agent.properties file.

Update this value against the key SCC_CERTIFICATE_ALIAS.

Restart the service after configuring the CA signed key pair to custom plug-in trust-store.

Configure certificate revocation list (CRL) for SnapCenter Custom Plug-ins

About this task
» SnapCenter Custom Plug-ins will search for the CRL files in a pre-configured directory.

 Default directory for the CRL files for SnapCenter Custom Plug-ins is ' opt/NetApp/snapcenter/scc/etc/crl'.

Steps

1.

You can modify and update the default directory in agent.properties file against the key CRL_PATH.

You can place more than one CRL file in this directory. The incoming certificates will be verified against
each CRL.

Configure the CA Certificate for the SnapCenter SAP HANA Plug-ins service on Windows host

You should manage the password of the custom plug-ins keystore and its certificate,
configure the CA certificate, configure root or intermediate certificates to the custom plug-
ins trust-store, and configure CA signed key pair to custom plug-ins trust-store with
SnapCenter Custom Plug-ins service to activate the installed digital certificate.

Custom plug-ins uses the file keystore.jks, which is located at C:\Program
Files\NetApp\SnapCenter\Snapcenter Plug-in Creator\etc both as its trust-store and key-store.

Manage password for custom plug-in keystore and alias of the CA signed key pair in use

Steps
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1. You can retrieve custom plug-in keystore default password from custom plug-in agent property file.
It is the value corresponding to the key KEYSTORE_PASS.
2. Change the keystore password:

keytool -storepasswd -keystore keystore.jks

@ If the "keytool" command is not recognized on the Windows command prompt, replace the
keytool command with its complete path.

C:\Program Files\Java\<jdk_version>\bin\keytool.exe" -storepasswd -keystore keystore.jks

3. Change the password for all aliases of private key entries in the keystore to the same password used for
the keystore:

keytool -keypasswd -alias "alias_name_in_cert" -keystore keystore.jks
Update the same for the key KEYSTORE_PASS in agent.properties file.

4. Restart the service after changing the password.

@ Password for custom plug-in keystore and for all the associated alias password of the
private key should be same.

Configure root or intermediate certificates to custom plug-in trust-store

You should configure the root or intermediate certificates without the private key to custom plug-in trust-store.

Steps

1. Navigate to the folder containing the custom plug-in keystore C:\Program
Files\NetApp\SnapCenter\Snapcenter Plug-in Creator\etc

2. Locate the file 'keystore.jks'.

3. List the added certificates in the keystore:
keytool -list -v -keystore keystore.jks
4. Add a root or intermediate certificate:
keytool -import -trustcacerts -alias myRootCA -file /root/USERTrustRSA_Root.cer -keystore keystore.jks

5. Restart the service after configuring the root or intermediate certificates to custom plug-in trust-store.

@ You should add the root CA certificate and then the intermediate CA certificates.

Configure CA signed key pair to custom plug-in trust-store
You should configure the CA signed key pair to the custom plug-in trust-store.

Steps

1. Navigate to the folder containing the custom plug-in keystore C:\Program
Files\NetApp\SnapCenter\Snapcenter Plug-in Creator\etc
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2. Locate the file keystore.jks.

3. List the added certificates in the keystore:
keytool -list -v -keystore keystore.jks
4. Add the CA certificate having both private and public key.

keytool -importkeystore -srckeystore /root/snapcenter.ssl.test.netapp.com.pfx -srcstoretype pkcs12
-destkeystore keystore.jks -deststoretype JKS

5. List the added certificates in the keystore.
keytool -list -v -keystore keystore.jks

6. Verify that the keystore contains the alias corresponding to the new CA certificate, which was added to the
keystore.

7. Change the added private key password for CA certificate to the keystore password.

Default custom plug-in keystore password is the value of the key KEYSTORE_PASS in agent.properties
file.

keytool -keypasswd -alias "alias_name_in_CA_cert" -keystore keystore.jks
8. Configure the alias name from CA certificate in agent.properties file.
Update this value against the key SCC_CERTIFICATE_ALIAS.
9. Restart the service after configuring the CA signed key pair to custom plug-in trust-store.

Configure certificate revocation list (CRL) for SnapCenter Custom Plug-ins

About this task

» To download the latest CRL file for the related CA certificate see How to update certificate revocation list
file in SnapCenter CA Certificate.

« SnapCenter Custom Plug-ins will search for the CRL files in a pre-configured directory.

 Default directory for the CRL files for SnapCenter Custom Plug-ins is 'C:\Program
Files\NetApp\SnapCenter\Snapcenter Plug-in Creator\ etc\crl'.

Steps
1. You can modify and update the default directory in agent.properties file against the key CRL_PATH.

2. You can place more than one CRL file in this directory.

The incoming certificates will be verified against each CRL.

Enable CA Certificates for plug-ins

You should configure the CA certificates and deploy the CA certificates in the SnapCenter
Server and the corresponding plug-in hosts. You should enable the CA certificate
validation for the plug-ins.

Before you begin
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* You can enable or disable the CA certificates using the run Set-SmCertificateSettings cmdlet.
* You can display the certificate status for the plug-ins using the Get-SmCertificateSettings.
The information regarding the parameters that can be used with the cmdlet and their descriptions can be

obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter Software
Cmdlet Reference Guide.

Steps
1. In the left navigation pane, click Hosts.
2. In the Hosts page, click Managed Hosts.
3. Select single or multiple plug-in hosts.
4. Click More options.
5. Select Enable Certificate Validation.

After you finish

The Managed Hosts tab host displays a padlock and the color of the padlock indicates the status of the
connection between SnapCenter Server and the plug-in host.

. indicates that the CA certificate is neither enabled nor assigned to the plug-in host.
* (5 indicates that the CA certificate is successfully validated.
* | indicates that the CA certificate could not be validated.

* @ indicates that the connection information could not be retrieved.

@ When the status is yellow or green, the data protection operations completes successfully.

Install SnapCenter Plug-in for VMware vSphere

If your database is stored on virtual machines (VMs), or if you want to protect VMs and
datastores, you must deploy the SnapCenter Plug-in for VMware vSphere virtual
appliance.

For information to deploy, see Deployment Overview.

Deploy CA certificate

To configure the CA Certificate with SnapCenter Plug-in for VMware vSphere, see Create or import SSL
certificate.

Configure the CRL file

SnapCenter Plug-in for VMware vSphere looks for the CRL files in a pre-configured directory. Default directory
of the CRL files for SnapCenter Plug-in for VMware vSphere is /opt/netapp/config/crl.

You can place more than one CRL file in this directory. The incoming certificates will be verified against each
CRL.
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Prepare for data protection

Prerequisites for using the SnapCenter Plug-in for SAP HANA Database

Before you use SnapCenter Plug-in for SAP HANA Database, the SnapCenter
administrator must install and configure the SnapCenter Server and perform the
prerequisite tasks.

* Install and configure SnapCenter Server.
* Log in to SnapCenter Server.

» Configure the SnapCenter environment by adding storage system connections and creating credentials, if
applicable.

* Install Java 1.7 or Java 1.8 on your Linux or Windows host.
You must set the Java path in the environmental path variable of the host machine.

« Set up SnapMirror and SnapVault, if you want backup replication.
* Install the HDBSQL client on the host where you will install the Plug-in for SAP HANA Database.
Configure the user store keys for the SAP HANA nodes that you will manage through this host.
* For SAP HANA database 2.0SPSO05, if you are using a SAP HANA database user account, ensure that you
have the following permissions to perform backup, restore, and clone operations in SnapCenter Server:
o Backup admin
o Catalog read
o Database backup admin

o Database recovery operator

How resources, resource groups, and policies are used for protecting SAP HANA
databases

Before you use SnapCenter, it is helpful to understand basic concepts related to the
backup, clone, and restore operations you want to perform. You interact with resources,
resource groups, and policies for different operations.

* Resources are typically SAP HANA databases that you back up or clone with SnapCenter.

» A SnapCenter resource group, is a collection of resources on a host.

When you perform an operation on a resource group, you perform that operation on the resources defined
in the resource group according to the schedule you specify for the resource group.

You can back up on demand a single resource or a resource group. You also can perform scheduled
backups for single resources and resource groups.

» The policies specify the backup frequency, replication, scripts, and other characteristics of data protection
operations.

When you create a resource group, you select one or more policies for that group. You can also select a
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policy when you perform a backup on demand for a single resource.

Think of a resource group as defining what you want to protect and when you want to protect it in terms of day
and time. Think of a policy as defining how you want to protect it. If you are backing up all databases, for
example, you might create a resource group that includes all of the databases in the host. You could then
attach two policies to the resource group: a daily policy and an hourly policy. When you create the resource
group and attach the policies, you might configure the resource group to perform a full backup daily.

Back up SAP HANA resources

Back up SAP HANA resources

You can either create a backup of a resource (database) or resource group. The backup
workflow includes planning, identifying the databases for backup, managing backup
policies, creating resource groups and attaching policies, creating backups, and
monitoring the operations.

The following workflow shows the sequence in which you must perform the backup operation:
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Define a backup strategy. :fw\‘

Configure HDB User Store Key and
HDBSOL OS User,

l

Determine whether the resources are
available for backup.

v

If needed, add resources,

i

Create a backup policy.

If you have multiple resources, create a
resource group, attach policies, and
create an optional schedule,

i

Back up the resource or resource group.

i

Monitor the backup operation.

|

View related backups and clones in
Topology page.

You can also use PowerShell cmdlets manually or in scripts to perform backup, restore, and clone operations.
The SnapCenter cmdlet help and the cmdlet reference information contain more information about PowerShell
cmdlets. SnapCenter Software Cmdlet Reference Guide.

Configure HDB User Store Key and HDBSQL OS User for the SAP HANA database

You must configure HDB User Store Key and HDBSQL OS User to perform data
protection operations on SAP HANA databases.

Before you begin

« If the SAP HANA database does not have the HDB Secure User Store Key and HDB SQL OS User
configured, a red padlock icon appears only for the autodiscovered resources. If during a subsequent
discovery operation, the configured HDB Secure User Store Key was found to be incorrect or did not
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provide access to the database itself, then the red padlock icon will reappear.

* You must configure the HDB Secure User Store Key and the HDB SQL OS user to be able to protect the
database or add it to a resource group to perform data protection operations.

* You must configure HDB SQL OS User to access the system database. If HDB SQL OS User is configured
to access only tenant database, the discovery operation will fail.

Steps

1. In the left navigation pane, click Resources and then select SnapCenter Plug-in for SAP HANA Database
from the list.

2. In the Resources page, select the resource type from the View list.
3. (Optional) Click ﬂ and select the host name.

You can then click ﬂ to close the filter pane.

4. Select the database, and then click Configure Database.

5. In the Configure database settings section, enter HDB Secure User Store Key.

@ The Plug-in host name is displayed and HDB SQL OS User is automatically populated to
<sid>adm.

6. Click OK.

You can modify the database configuration from the Topology page.

Discover resources and prepare multitenant database containers for data
protection

Discover the databases automatically

Resources are SAP HANA databases and Non-data Volume on the Linux host that are
managed by SnapCenter. You can add these resources to resource groups to perform
data protection operations after you discover the SAP HANA databases that are
available.

Before you begin

* You must have already completed tasks such as installing the SnapCenter Server, adding HDB User Store
Key, adding hosts, and setting up the storage system connections.

* You must have configured the HDB Secure User Store Key and HDB SQL OS user on the Linux host.

> You must configure the HDB User Store Key with SID adm user. For example, for HANA system with
A22 as the SID, the HDB User Store Key must be configured with a22adm.

« SnapCenter Plug-in for SAP HANA Database does not support automatic discovery of the resources
residing on RDM/VMDK virtual environments. You must provide the storage information for virtual
environments while adding the databases manually.

About this task

After installing the plug-in, all the resources on that Linux host are automatically discovered and displayed on
the Resources page.

The automatically discovered resources cannot be modified or deleted.
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Steps

1. In the left navigation pane, click Resources, and then select the Plug-in for SAP HANA Database from the
list.

2. In the Resources page select the resource type from the View list.

3. (Optional) Click ﬂ and then select the host name.
You can then click ﬂ to close the filter pane.
4. Click Refresh Resources to discover the resources available on the host.

The resources are displayed along with information such as resource type, host name, associated
resource groups, backup type, policies and overall status.

o If the database is on a NetApp storage and not protected, then Not protected is displayed in the Overall
Status column.

o If the database is on a NetApp storage system and protected, and if there is no backup operation
performed, then Backup not run is displayed in the Overall Status column. The status will otherwise
change to Backup failed or Backup succeeded based on the last backup status.

If the SAP HANA database does not have a HDB Secure User Store Key configured, a red

@ padlock icon appears next to the resource. If during a subsequent discovery operation, the
configured HDB Secure User Store Key was found to be incorrect or did not provide access to
the database itself, then the red padlock icon will reappear.

@ You must refresh the resources if the databases are renamed outside of SnapCenter.

After you finish

You must configure the HDB Secure User Store Key and HDBSQL OS User to be able to protect the database
or add it to the resource group to perform data protection operations.

Configure HDB User Store Key and HDBSQL OS User for the SAP HANA database

Prepare multitenant database containers for data protection

For SAP HANA hosts directly registered in SnapCenter, installing or upgrading the
SnapCenter Plug-in for SAP HANA Database will trigger an automatic discovery for
resources on the host. After installing or upgrading the plug-in, for every multitenant
database containers (MDC) resource that was located on the plug-in host, another MDC
resource will be automatically discovered with a different GUID format and registered in
SnapCenter. The new resource will be in “locked” state.

About this task

For example, in SnapCenter 4.2, if E90 MDC resource was located on the plug-in host and registered
manually, after upgrading to SnapCenter 4.3, another E90 MDC resource with a different GUID will be
discovered and registered in SnapCenter.

The backups associated with the resource of SnapCenter 4.2 and earlier versions must be
@ retained until the expiry of the retention period. After the retention period expires, you can delete
the old MDC resource and continue to manage the new auto discovered MDC resource.
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0ld MDC resource is the MDC resource for a plug-in host that was manually added in SnapCenter 4.2 or
earlier releases.

Perform the following steps to start using the new resource discovered in SnapCenter 4.3 for data protection
operations:

Steps

1. In the Resources page, select the old MDC resource with backups added to the earlier SnapCenter
release, and place it in “maintenance mode” from the Topology page.

If the resource is part of a resource group, place the resource group in “maintenance mode”.

2. Configure the new MDC resource discovered after upgrading to SnapCenter 4.3 by selecting the new
resource from the Resources page.

“‘New MDC resource” is the newly discovered MDC resource that was discovered once the SnapCenter
Server and the plug-in host was upgraded to 4.3. The new MDC resource can be identified as a resource
with the same SID as the old MDC resource, for a given host, and with a red padlock icon next to it in the
Resources page.

3. Protect the new MDC resource discovered after upgrading to SnapCenter 4.3 by selecting protection
policies, schedules, and notification settings.

4. Delete the backups taken in SnapCenter 4.2 or earlier releases based on the retention settings.

5. Delete the resource group from the Topology page.

6. Delete the old MDC resource from the Resources page.
For example, if the primary Snapshot copies retention period is 7 days and secondary Snapshot copies

retention is 45 days, after 45 days are complete and after all the backups are deleted, you must delete the
resource group and the old MDC resource.

Related information

Configure HDB User Store Key and HDBSQL OS User for the SAP HANA database

View SAP HANA database backups and clones in the Topology page

Add resources manually to the plug-in host

Automatic discovery is not supported for certain HANA instances. You must add these
resources manually.

Before you begin

* You must have completed tasks such as installing the SnapCenter Server, adding hosts, setting up storage
system connections, and adding HDB User Store Key.

* For SAP HANA system replication, it is recommended to add all the resources of that HANA system into
one resource group and take a resource group backup. This ensures a seamless backup during takeover-
failback mode.

Create resource groups and attach policies.

About this task
Automatic discovery is not supported for the following configurations:
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RDM and VMDK layouts

@ In case the above resources are discovered, the data protection operations are not

supported on these resources.

HANA multiple-host configuration
Multiple instances on the same host

Multitier scale out HANA System Replication

Cascaded replication environment in System Replication mode

Steps

1. In the left navigation pane, select the SnapCenter Plug-in for SAP HANA Database from the drop-down list,

and then click Resources.

2. In the Resources page, click Add SAP HANA Database.

3. In the Provide Resource Details page, perform the following actions:

For this field...

Resource Type

HANA System Name

SID

Plug-in Host

HDB Secure User Store Keys

HDBSQL OS User

Do this...

Enter the resource type. Resource types are Single
Container, Multitenant Database Container (MDC),
and Non-data Volume.

Enter the descriptive SAP HANA system name. This
option is available only if you selected Single
Container or MDC resource types.

Enter the system ID (SID). The installed SAP HANA
system is identified by a single SID.

Select the plug-in host.

Enter the key to connect to the SAP HANA system.

The key contains the login information to connect to
the database.

For SAP HANA System Replication, secondary user
key is not validated. This will be used during
takeover.

Enter the user name for whom the HDB Secure
User Store Key is configured. For Windows, it is
mandatory for the HDBSQL OS User to be the
SYSTEM user. Therefore, you must configure the
HDB Secure User Store Key for the SYSTEM user.

4. In the Provide Storage Footprint page, select a storage system and choose one or more volumes, LUNSs,

and gtrees, and then click Save.
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Optional: You can click the * icon to add more volumes, LUNs, and gtrees from other storage systems.
5. Review the summary, and then click Finish.

The databases are displayed along with information such as the SID, plug-in host, associated resource
groups and policies, and overall status

If you want to provide users access to resources, you must assign the resources to the users. This enables
users to perform the actions for which they have permissions on the assets that are assigned to them.

Add a user or group and assign role and assets
After adding the databases, you can modify the SAP HANA database details.
You cannot modify the following if there are backups associated with the SAP HANA resource:

» Multitenant database containers (MDC): SID, or HDBSQL Client (plug-in) Host
* Single Container: SID or HDBSQL Client (plug-in) Host

* Non-data Volume: Resource name, Associated SID, or Plug-in Host

Create backup policies for SAP HANA databases

Before you use SnapCenter to back up SAP HANA database resources, you must create
a backup policy for the resource or resource group that you want to back up. A backup
policy is a set of rules that governs how you manage, schedule, and retain backups.

Before you begin
* You must have defined your backup strategy.

For details, see the information about defining a data protection strategy for SAP HANA databases.

* You must have prepared for data protection by completing tasks such as installing SnapCenter, adding
hosts, setting up storage system connections, and adding resources.

* The SnapCenter administrator must have assigned the SVMs for both the source and destination volumes

to you if you are replicating Snapshot copies to a mirror or vault.

Additionally, you can specify replication, script, and application settings in the policy. These options saves
time when you want to reuse the policy for another resource group.

About this task
+ SAP HANA System Replication

> You can protect the primary SAP HANA system and all the data protection operations can be
performed.

> You can protect the secondary SAP HANA system, but the backups cannot be created.

After the failover, all the data protection operation can be performed as the secondary SAP HANA
system becomes the primary SAP HANA system.

You cannot create a backup for SAP HANA data volume, but SnapCenter continues to protect the Non-
data Volumes (NDV).
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Steps

1

2
3
4
5

. In the left navigation pane, click Settings.

. In the Settings page, click Policies.

. Click New.

. In the Name page, enter the policy name and description.
. In the Settings page, perform the following steps:

> Choose backup type:

If you want to... Do this...

Perform an integrity check of the database Select File-Based Backup. Only active tenants
are backed up.

Create a backup using Snapshot copy technology Select Snapshot Based.

o Specify the schedule type by selecting On demand, Hourly, Daily, Weekly, or Monthly.

You can specify the schedule (start date, end date, and frequency) for the backup

@ operation while creating a resource group. This enables you to create resource groups
that share the same policy and backup frequency, but also enables you to assign
different backup schedules to each policy.

@ If you have scheduled for 2:00 a.m., the schedule will not be triggered during daylight
saving time (DST).

> In the Custom backup settings section, provide any specific backup settings that have to be passed
to the plug-in in key-value format.

You can provide multiple key-values to be passed to the plug-in.

6. In the Retention page, specify the retention settings for the backup type and the schedule type selected in

the Backup Type page:
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If you want to...

Keep a certain number of Snapshot copies

Then...

Select Total Snapshot copies to keep, and then
specify the number of Snapshot copies that you
want to keep.

If the number of Snapshot copies exceeds the
specified number, the Snapshot copies are deleted
with the oldest copies deleted first.

®

The maximum retention value is
1018 for resources on ONTAP 9.4 or
later, and 254 for resources on
ONTAP 9.3 or earlier. Backups will
fail if retention is set to a value higher
than what the underlying ONTAP
version supports.

For Snapshot copy-based backups,
you must set the retention count to 2
or higher if you plan to enable
SnapVault replication. If you set the
retention count to 1, the retention
operation might fail because the first
Snapshot copy is the reference
Snapshot copy for the SnapVault
relationship until a newer Snapshot
copy is replicated to the target.

For SAP HANA system replication, it
is recommended to add all the
resources of the SAP HANA system
into one resource group. This
ensures that the right number of
backups are retained.

For SAP HANA System Replication,
the total Snapshot copies taken will
be equal to the retention set for the
resource group. The removal of the
oldest Snapshot copy is based on
which node the oldest Snapshot copy
is located. For example, the retention
is set to 7 for a resource group with
SAP HANA System Replication
primary and SAP HANA System
Replication secondary. You can take
a maximum of 7 Snapshot copies at
a time including both SAP HANA
System Replication primary and SAP
HANA System Replication
secondary.
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If you want to... Then...

Keep the Snapshot copies for a certain number of  Select Keep Snapshot copies for, and then
days specify the number of days for which you want to
keep the Snapshot copies before deleting them.

7. For Snapshot copy-based backups, specify the replication settings in the Replication page:

For this field... Do this...

Update SnapMirror after creating a local Select this field to create mirror copies of the

Snapshot copy backup sets on another volume (SnapMirror
replication).

If the protection relationship in ONTAP is of type
Mirror and Vault and if you select only this option,
the Snapshot copy created on the primary will not
be transferred to the destination, but will be listed in
the destination. If this Snapshot copy is selected
from the destination to perform a restore operation,
then the Secondary Location is not available for the
selected vaulted/mirrored backup error message is

displayed.
Update SnapVault after creating a local Select this option to perform disk-to-disk backup
Snapshot copy replication (SnapVault backups).
Secondary policy label Select a Snapshot label.

Depending on the Snapshot copy label that you
select, ONTAP applies the secondary Snapshot
copy retention policy that matches the label.

If you have selected Update
SnapMirror after creating a local
Snapshot copy, you can optionally
@ specify the secondary policy label.
However, if you have selected
Update SnapVault after creating a
local Snapshot copy, you should
specify the secondary policy label.

Error retry count Enter the maximum number of replication attempts
that can be allowed before the operation stops.

@ You should configure SnapMirror retention policy in ONTAP for the secondary storage to
avoid reaching the maximum limit of Snapshot copies on the secondary storage.

8. Review the summary, and then click Finish.
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Create resource groups and attach policies

A resource group is the container to which you must add resources that you want to back
up and protect. A resource group enables you to back up all the data that is associated
with a given application simultaneously. A resource group is required for any data
protection job. You must also attach one or more policies to the resource group to define
the type of data protection job that you want to perform.

About this task

To create SAP HANA system replication backups, it is recommended to add all the resources of the SAP
HANA system into one resource group. This ensures a seamless backup during takeover-failback mode.

Steps
1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.

2. In the Resources page, click New Resource Group.

3. In the Name page, perform the following actions:

For this field... Do this...

Name Enter a name for the resource group.

@ The resource group name should not
exceed 250 characters.

Tags Enter one or more labels that will help you later
search for the resource group.

For example, if you add HR as a tag to multiple
resource groups, you can later find all resource
groups associated with the HR tag.

Use custom name format for Snapshot copy Select this check box, and enter a custom name
format that you want to use for the Snapshot copy
name.

For example, customtext_resource
group_policy_hostname or resource
group_hostname. By default, a timestamp is
appended to the Snapshot copy name.

4. In the Resources page, select a host name from the Host drop-down list and resource type from the
Resource Type drop-down list.

This helps to filter information on the screen.

5. Select the resources from the Available Resources section, and then click the right arrow to move them to
the Selected Resources section.
6. In the Application Settings page, do the following:

a. Click the Backups arrow to set additional backup options:
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Enable consistency group backup and perform the following tasks:

For this field...

Afford time to wait for Consistency Group
Snapshot operation to complete

Disable WAFL Sync

Do this...

Select Urgent, Medium, or Relaxed to specify
the wait time for Snapshot copy operation to
complete.

Urgent = 5 seconds, Medium = 7 seconds, and
Relaxed = 20 seconds.

Select this to avoid forcing a WAFL consistency
point.

3 6

Mame Resources

@ ‘

Applcation Settings Poliches

Backups

B Enable consistency group backup

® Urgent
Medilem
) Relaxed
[ Disable WAFL Sync

SCripts
Custom Configurations

Snapshot Copy Tool

Affesrd tarree 1o wait for Consistency Group Snapgshol aperastion 1o complete

Modfication Summary

& ee

b. Click the Scripts arrow and enter the pre and post commands for quiesce, Snapshot copy, and
unquiesce operations. You can also enter the pre commands to be executed before exiting in the event

of a failure.

c. Click the Custom Configurations arrow and enter the custom key-value pairs required for all data

protection operations using this resource.

Parameter

ARCHIVE_LOG_ENABLE

Setting
(Y/N)

Description

Enables the archive log
management to delete the
archive logs.



Parameter Setting Description

ARCHIVE_LOG_RETENTION  number_of_days Specifies the number of days the
archive logs are retained.

This setting must be equal to or
greater than
NTAP_SNAPSHOT_

RETENTIONS.
ARCHIVE_LOG_DIR change_info_directory/logs Specifies the path to the

directory that contains the

archive logs.
ARCHIVE_LOG_EXT file_extension Specifies the archive log file

extension length.

For example, if the archive log is
log_backup 0 0 0 0.16151855
1942 9 and if the file_extension
value is 5, then the extension of
the log will retain 5 digits, which

is 16151.
ARCHIVE_LOG_RECURSIVE_ (Y/N) Enables the management of
SE ARCH archive logs within

subdirectories.

You should use this parameter if
the archive logs are located
under subdirectories.

@ The custom key-value pairs are supported for SAP HANA Linux plug-in systems and not
supported for SAP HANA database registered as a centralized windows plug-in.

d. Click the Snapshot Copy Tool arrow to select the tool to create Snapshot copies:

If you want... Then...

SnapCenter to use the plug-in for Windows and Select SnapCenter with File System

put the file system into a consistent state before ~ Consistency.

creating a Snapshot copy. For Linux resources,

this option is not applicable. This option is not applicable for SnapCenter Plug-
in for SAP HANA Database.

SnapCenter to create a storage level Snapshot Select SnapCenter without File System
copy Consistency.

To enter the command to be executed on the host Select Other, and then enter the command to be
to create Snapshot copies. executed on the host to create a Snapshot copy.
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7. In the Policies page, perform the following steps:

a. Select one or more policies from the drop-down list.

@ You can also create a policy by clicking

The policies are listed in the Configure schedules for selected policies section.

b.
In the Configure Schedules column, click *  forthe policy you want to configure.

c. In the Add schedules for policy policy name dialog box, configure the schedule, and then click OK.
Where, policy_name is the name of the policy that you have selected.
The configured schedules are listed in the Applied Schedules column.

Third party backup schedules are not supported when they overlap with SnapCenter backup
schedules.

8. In the Notification page, from the Email preference drop-down list, select the scenarios in which you want
to send the emails.

You must also specify the sender and receiver email addresses, and the subject of the email. The SMTP
server must be configured in Settings > Global Settings.

9. Review the summary, and then click Finish.

Back up SAP HANA databases

If a resource is not yet part of any resource group, you can back up the resource from the
Resources page.

Before you begin
* You must have created a backup policy.

* If you want to back up a resource that has a SnapMirror relationship with a secondary storage, the ONTAP
role assigned to the storage user should include the “snapmirror all” privilege. However, if you are using the
“vsadmin” role, then the “snapmirror all” privilege is not required.

» For Snapshot copy based backup operation, ensure that all the tenant databases are valid and active.

» To create SAP HANA system replication backups, it is recommended to add all the resources of the SAP
HANA system into one resource group. This ensures a seamless backup during takeover-failback mode.
Create resource groups and attach policies.

Back up resource groups

* If you want to create a file-based backup when one or more tenant databases are down, set the
ALLOW_FILE_BASED_BACKUP_IFINACTIVE_TENANTS_PRESENT parameter to YES in the HANA

properties file using Set-SmConfigSettings cmdlet.
The information regarding the parameters that can be used with the cmdlet and their descriptions can be

obtained by running Get-Help command_name. Alternatively, you can also refer to the Cmdlet Reference
Guide
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* For pre and post commands for quiesce, Snapshot copy, and unquiesce operations, you should check if
the commands exist in the command list available on the plug-in host from the following paths:

o For Windows: C:\Program Files\NetApp\SnapCenter\Snapcenter Plug-in
Creator\etc\allowed commands.config

o Linux: _/var/opt/snapcenter/scc/allowed_commands.config
@ If the commands do not exist in the command list, then the operation will fail.

Steps
1. In the left navigation pane, select Resources, and then select the appropriate plug-in from the list.

2. In the Resource page, filter resources from the View drop-down list based on resource type.

Select ﬂ and then select the host name and the resource type to filter the resources. You can then select
L to close the filter pane.

3. Select the resource that you want to back up.

4. In the Resource page, select Use custom name format for Snapshot copy, and then enter a custom
name format that you want to use for the Snapshot copy name.

For example, customtext _policy hostname or resource _hostname. By default, a timestamp is appended to
the Snapshot copy name.

5. In the Application Settings page, do the following:

o Select the Backups arrow to set additional backup options:

Enable consistency group backup, if needed, and perform the following tasks:

For this field... Do this...
Afford time to wait for "Consistency Group Select Urgent, or Medium, or Relaxed to specify
Snapshot" operation to complete the wait time for Snapshot copy operation to

finish. Urgent = 5 seconds, Medium = 7 seconds,
and Relaxed = 20 seconds.

Disable WAFL Sync Select this to avoid forcing a WAFL consistency
point.

o Select the Scripts arrow to run pre and post commands for quiesce, Snapshot copy, and unquiesce
operations.

You can also run pre commands before exiting the backup operation. Prescripts and postscripts are run
in the SnapCenter Server.

o Select the Custom Configurationsarrow, and then enter the custom value pairs required for all jobs
using this resource.

o Select the Snapshot Copy Tool arrow to select the tool to create Snapshot copies:
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If you want... Then...

SnapCenter to create a storage-level Snapshot Select SnapCenter without File System
copy Consistency.

SnapCenter to use the plug-in for Windows to put = Select SnapCenter with File System
the file system into a consistent state and then Consistency.
create a Snapshot copy

To enter the command to create a Snapshot copy Select Other, and then enter the command to
create a Snapshot copy.

—© @ ‘ : s

Name Resources Applcation Settings Poliches Modfication Summary

Backiips &

B Enable consistency group backup

Afford time to wait for Consistency Group Snapshot aperation to compéete
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e

Custom Configurations
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snapshot Copy Tool

6. In the Policies page, perform the following steps:

a. Select one or more policies from the drop-down list.

@ You can also create a policy by clicking *

In the Configure schedules for selected policies section, the selected policies are listed.

b.
Select

schedule.

* inthe Configure Schedules column for the policy for which you want to configure a

c. In the Add schedules for policy policy _name dialog box, configure the schedule, and then select OK.
policy_name is the name of the policy that you selected.
The configured schedules are listed in the Applied Schedules column.

7. In the Notification page, from the Email preference drop-down list, select the scenarios in which you want
to send the emails.
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You must also specify the sender and receiver email addresses, and the subject of the email. SMTP must
also be configured in Settings > Global Settings.

8. Review the summary, and then select Finish.
The resources topology page is displayed.

9. Select Back up Now.
10. In the Backup page, perform the following steps:
a. If you applied multiple policies to the resource, from the Policy drop-down list, select the policy that you
want to use for backup.

If the policy selected for the on-demand backup is associated with a backup schedule, the on-demand
backups will be retained based on the retention settings specified for the schedule type.
b. Select Backup.
11. Monitor the operation progress by clicking Monitor > Jobs.
> In MetroCluster configurations, SnapCenter might not be able to detect a protection relationship after a
failover.

For information, see: Unable to detect SnapMirror or SnapVault relationship after MetroCluster failover

o If you are backing up application data on VMDKSs and the Java heap size for the SnapCenter Plug-in
for VMware vSphere is not large enough, the backup might fail.

To increase the Java heap size, locate the script file /opt/netapp/init_scripts/scvservice. In that script,
the do_start method command starts the SnapCenter VMware plug-in service. Update that command
to the following: Java -jar -Xmx8192M -Xms4096M

Back up resource groups

A resource group is a collection of resources on a host. A backup operation on the
resource group is performed on all resources defined in the resource group.

Before you begin
* You must have created a resource group with a policy attached.

* If you want to back up a resource that has a SnapMirror relationship with a secondary storage, the ONTAP
role assigned to the storage user should include the “snapmirror all” privilege. However, if you are using the
“vsadmin” role, then the “snapmirror all” privilege is not required.

About this task

You can back up a resource group on demand from the Resources page. If a resource group has a policy
attached and a schedule configured, then backups occur automatically according to the schedule.

Steps
1. In the left navigation pane, select Resources, and then select the appropriate plug-in from the list.

2. In the Resources page, select Resource Group from the View list.

You can search the resource group either by entering the resource group name in the search box or by
selecting ﬂ and then selecting the tag. You can then select ﬂ to close the filter pane.
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3. In the Resource Groups page, select the resource group that you want to back up, and then select Back
up Now.

4. In the Backup page, perform the following steps:

a. If you associated multiple policies with the resource group, from the Policy drop-down list, select the
policy that you want to use for backup.

If the policy selected for the on-demand backup is associated with a backup schedule, the on-demand
backups will be retained based on the retention settings specified for the schedule type.

b. Select Backup.

5. Monitor the operation progress by selecting Monitor > Jobs.

Create a storage system connection and a credential using PowerShell cmdlets for
SAP HANA database

You must create a storage virtual machine (SVM) connection and a credential before
using PowerShell cmdlets to back up, restore, or clone SAP HANA databases.

Before you begin
* You should have prepared the PowerShell environment to execute the PowerShell cmdlets.

* You should have the required permissions in the Infrastructure Admin role to create storage connections.

* You should ensure that the plug-in installations are not in progress.

Host plug-in installations must not be in progress while adding a storage system connection because the
host cache might not be updated and databases status might be displayed in the SnapCenter GUI as “Not
available for backup” or “Not on NetApp storage”.

» Storage system names should be unique.

SnapCenter does not support multiple storage systems with the same name on different clusters. Each
storage system that is supported by SnapCenter should have a unique name and a unique data LIF IP
address.

Steps
1. Initiate a PowerShell connection session by using the Open-SmConnection cmdlet.

PS C:\> Open-SmStorageConnection
2. Create a new connection to the storage system by using the Add-SmStorageConnection cmdlet.

PS C:\> Add-SmStorageConnection -Storage test vsl -Protocol Https
-Timeout 60

3. Create a new credential by using the Add-SmCredential cmdlet.

This example shows how to create a new credential named FinanceAdmin with Windows credentials:
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PS C:> Add-SmCredential -Name FinanceAdmin -AuthMode Windows
-Credential sddev\administrator

4. Add the SAP HANA communication host to SnapCenter Server.

PS C:> Add-SmHost -HostName 10.232.204.61 -0OSType Windows -RunAsName
FinanceAdmin -PluginCode hana

5. Install the package and the SnapCenter Plug-in for SAP HANA Database on the host.

For Linux:

PS C:> Install-SmHostPackage -HostNames 10.232.204.61 -ApplicationCode
hana

For Windows:

Install-SmHostPackage -HostNames 10.232.204.61 -ApplicationCode hana
-FilesystemCode scw —-RunAsName FinanceAdmin

6. Set the path to the HDBSQL client.

For Windows:

PS C:> Set-SmConfigSettings -Plugin -HostName 10.232.204.61 -PluginCode
hana -configSettings @{"HANA HDBSQL CMD" = "C:\Program
Files\sap\hdbclient\hdbsgl.exe"}

For Linux:

Set-SmConfigSettings -Plugin -HostName scs-hana.gdl.englab.netapp.com
-PluginCode hana -configSettings
@{"HANA HDBSQL CMD"="/usr/sap/hdbclient/hdbsqgl"}

The information regarding the parameters that can be used with the cmdlet and their descriptions can be

obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter Software
Cmdlet Reference Guide.

Back up databases using PowerShell cmdlets

Backing up a database includes establishing a connection with the SnapCenter Server,

53


https://docs.netapp.com/us-en/snapcenter-cmdlets-49/index.html
https://docs.netapp.com/us-en/snapcenter-cmdlets-49/index.html

adding resources, adding a policy, creating a backup resource group, and backing up.

Before you begin
* You must have prepared the PowerShell environment to execute the PowerShell cmdlets.

* You must have added the storage system connection and created a credential.

Steps

1. Initiate a connection session with the SnapCenter Server for a specified user by using the Open-
SmConnection cmdlet.

Open-smconnection -SMSbaseurl https:\\snapctr.demo.netapp.com:8146\

The username and password prompt is displayed.
2. Add resources by using the Add-SmResources cmdlet.

This example shows how to add a SAP HANA database of SingleContainer type:

C:\PS> Add-SmResource -HostName '10.232.204.42' -PluginCode 'HANA'
-DatabaseName H10 -ResourceType SingleContainer -StorageFootPrint
(@{"VolumeName"="HanaDatalO";"StorageSystem"="vserver scauto primary"})
-SID 'H10' -filebackuppath '/tmp/HanaFileLog' -userstorekeys 'HS10'
-osdbuser 'hlOadm' -filebackupprefix 'H10 '

This example shows how to add a SAP HANA database of MultipleContainers type:

C:\PS> Add-SmResource -HostName 'vp-hana2.gdl.englab.netapp.com'
-PluginCode 'HANA' -DatabaseName MDC MT -ResourceType MultipleContainers
-StorageFootPrint
(@{"VolumeName"="VP HANA2 data";"StorageSystem"="buck.gdl.englab.netapp.
com"}) -sid 'Al2' -userstorekeys 'Al2KEY' -TenantType 'MultiTenant'

This example shows how to create a non-data volume resource:

C:\PS> Add-SmResource -HostName 'SNAPCENTERN42.sccore.test.com'
-PluginCode 'hana' -ResourceName NonDataVolume -ResourceType
NonDataVolume -StorageFootPrint

(@{"VolumeName"="ng pvol";"StorageSystem"="vserver scauto primary"})
-sid 'S10'

3. Create a backup policy by using the Add-SmPolicy cmdlet.

This example creates a backup policy for a Snapshot copy-based backup:
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C:\PS> Add-SmPolicy -PolicyName hana snapshotbased -PolicyType Backup
-PluginPolicyType hana -BackupType SnapShotBasedBackup

This example creates a backup policy for a File-Based backup:

C:\PS> Add-SmPolicy -PolicyName hana Filebased -PolicyType Backup
-PluginPolicyType hana -BackupType FileBasedBackup

4. Protect the resource or add a new resource group to SnapCenter by using the Add-SmResourceGroup
cmdlet.

This example protects a single container resource:

C:\PS> Add-SmProtectResource -PluginCode HANA -Policies
hana snapshotbased, hana Filebased
-Resources @{"Host"="host.example.com";"UID"="SID"} -Description test

—-usesnapcenterwithoutfilesystemconsistency

This example protects a multiple containers resource:

C:\PS> Add-SmProtectResource -PluginCode HANA -Policies
hana snapshotbased, hana Filebased

-Resources @{"Host"="host.example.com";"UID"="MDC\SID"} -Description
test -usesnapcenterwithoutfilesystemconsistency

This example creates a new resource group with the specified policy and resources:

C:\PS> Add-SmResourceGroup -ResourceGroupName
'ResourceGroup with SingleContainer MultipleContainers Resources'
—-Resources
@ (@R{"Host"="sccorelinux6l.sccore.test.com";"Uid"="SID"}, QR{"Host"="sccore
linux62.sccore.test.com";"Uid"="MDC\SID"})

-Policies hana snapshotbased,hana Filebased
-usesnapcenterwithoutfilesystemconsistency -plugincode 'HANA'

This example creates a non-data volume resource group:
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C:\PS> Add-SmResourceGroup -ResourceGroupName

'Mixed RG backup when Remove Backup throguh BackupName windows'
—-Resources
@(@{"Host"="SNAPCENTERN42.sccore.test.com";"Uid"="H11";"PluginName"="han
a"},@{"Host"="SNAPCENTERN42.sccore.test.com";"Uid"="MDC\H31"; "PluginName
"="hana"}, Q{"Host"="SNAPCENTERN42.sccore.test.com";"Uid"="NonDataVolume\
S10\NonDataVolume"; "PluginName"="hana"}) -Policies hanaprimary

5. Initiate a new backup job by using the New-SmBackup cmdlet.

This example shows how to backup a resource group:

C:\PS> New-SMBackup -ResourceGroupName
'ResourceGroup with SingleContainer MultipleContainers Resources'
-Policy hana snapshotbased

This example backs up a protected resource:

C:\PS> New-SMBackup -Resources
@{"Host"="10.232.204.42";"Uid"="MDC\SID";"PluginName"="hana"} -Policy
hana Filebased

6. Monitor the job status (running, completed, or failed) by using the Get-smJobSummaryReport cmdlet.

PS C:\> Get-smJobSummaryReport -JobID 123

7. Monitor the backup job details like backup ID, backup name to perform restore or clone operation by using
the Get-SmBackupReport cmdlet.
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PS C:\> Get-SmBackupReport -JobId 351

Output:
BackedUpObjects
FailedObjects
IsScheduled
HasMetadata
SmBackupId

SmJobId
StartDateTime
EndDateTime
Duration
CreatedDateTime
Status
ProtectionGroupName
SmProtectionGroupId
PolicyName
SmPolicyId
BackupName

2016 23.20.46.2758
VerificationStatus
VerificationStatuses
SmJobError
BackupType
CatalogingStatus
CatalogingStatuses
ReportDataCreatedDateTime

Monitor backup operations

About this task
The following icons appear on the Jobs page and indicate the corresponding state of the operations:

In progress
Completed successfully

= Failed

{DB1}

{}

False

False

269

2361

10/4/2016 11:20:45 PM
10/4/2016 11:21:32 PM
00:00:46.2536470

10/4/2016 11:21:09 PM
Completed

Verify ASUP Message windows
211

test2

20

Verify ASUP Message windows scc54 10-04-

NotVerified

SCC_BACKUP
NotApplicable

The information regarding the parameters that can be used with the cmdlet and their descriptions can be
obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter Software
Cmdlet Reference Guide.

Monitor SAP HANA databases backup operations

You can monitor the progress of different backup operations by using the
SnapCenterdobs page. You might want to check the progress to determine when it is
complete or if there is an issue.
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Completed with warnings or could not start due to warnings
* D Queued
e @ Canceled

Steps
1. In the left navigation pane, click Monitor.

2. In the Monitor page, click Jobs.

3. In the Jobs page, perform the following steps:
a. Click ﬂ to filter the list so that only backup operations are listed.
b. Specify the start and end dates.
c. From the Type drop-down list, select Backup.

d. From the Status drop-down, select the backup status.

0]

. Click Apply to view the operations completed successfully.

4. Select a backup job, and then click Details to view the job details.

Though the backup job status displays , when you click on job details you might see that
some of the child tasks of the backup operation are still in progress or marked with warning
signs.

5. In the Job Details page, click View logs.

The View logs button displays the detailed logs for the selected operation.

Monitor data protection operations on SAP HANA databases in the Activity pane

The Activity pane displays the five most recent operations performed. The Activity pane
also displays when the operation was initiated and the status of the operation.

The Activity pane displays information regarding backup, restore, clone, and scheduled backup operations. If
you are using Plug-in for SQL Server or Plug-in for Exchange Server, the Activity pane also displays

information about the reseed operation.

Steps
1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.

2. Click on the Activity pane to view the five most recent operations.

When you click one of the operations, the operation details are listed in the Job Details page.

Cancel backup operations for SAP HANA
You can cancel backup operations that are queued.
What you will need

* You must be logged in as the SnapCenter Admin or job owner to cancel operations.
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* You can cancel a backup operation from either the Monitor page or the Activity pane.

* You cannot cancel a running backup operation.

* You can use the SnapCenter GUI, PowerShell cmdlets, or CLI commands to cancel the backup operations.
» The Cancel Job button is disabled for operations that cannot be canceled.

* If you selected All members of this role can see and operate on other members objects in
Users\Groups page while creating a role, you can cancel the queued backup operations of other members
while using that role.

Steps

1. Perform one of the following actions:

From the... Action

Monitor page a. In the left navigation pane, click Monitor >
Jobs.

b. Select the operation, and then click Cancel

Job.

Activity pane a. After initiating the backup operation, click on
the Activity pane to view the five most recent
operations.

b. Select the operation.

c. In the Job Details page, click Cancel Job.

The operation is canceled, and the resource is reverted to the previous state.

View SAP HANA database backups and clones in the Topology page

When you are preparing to back up or clone a resource, you might find it helpful to view a
graphical representation of all backups and clones on the primary and secondary storage.

About this task

You can review the following icons in the Manage Copies view to determine whether the backups and clones
are available on the primary or secondary storage (Mirror copies or Vault copies).

displays the number of backups and clones that are available on the primary storage.

—
L
. displays the number of backups and clones that are mirrored on the secondary storage using
SnapMirror technology.

U displays the number of backups and clones that are replicated on the secondary storage using
SnapVault technology.
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The number of backups displayed includes the backups deleted from the secondary storage.
@ For example, if you created 6 backups using a policy to retain only 4 backups, the number of
backups displayed is 6.

Clones of a backup of a version-flexible mirror on a mirror-vault type volume are displayed in the
@ topology view, but the mirror backup count in the topology view does not include the version-
flexible backup.

@ For SAP HANA system replication primary resources, the restore and delete operations are
supported and for secondary resources, the clone operation is supported.

In the Topology page, you can see all of the backups and clones that are available for the selected resource or
resource group. You can view the details of those backups and clones, and then select them to perform data
protection operations.

Steps
1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.

2. In the Resources page, either select the resource or resource group from the View drop-down list.

3. Select the resource either from the resource details view or from the resource group details view.
If the resource is protected, the topology page of the selected resource is displayed.

4. Review the Summary card to see a summary of the number of backups and clones available on the
primary and secondary storage.

The Summary Card section displays the total number of File-Based backups, Snapshot copy backups,
and clones.

Clicking the Refresh button starts a query of the storage to display an accurate count.

5. In the Manage Copies view, click Backups or Clones from the primary or secondary storage to see details
of a backup or clone.

The details of the backups and clones are displayed in a table format.

6. Select the backup from the table, and then click the data protection icons to perform restore, clone, and
delete operations.

@ You cannot rename or delete backups that are on the secondary storage.

7. If you want to delete a clone, select the clone from the table, and then click Jy .

8. If you want to split a clone, select the clone from the table, and then click .J -

Restore SAP HANA Databases

Restore workflow

The restore and recovery workflow includes planning, performing the restore operations,
and monitoring the operations.
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The following workflow shows the sequence in which you must perform the restore operation:

Define a restore strategy.

l l

Restore and recover the auto discovered
Restore the manually added resource.

database.
v v

Monitor the restore operation,

You can also use PowerShell cmdlets manually or in scripts to perform backup, restore, and clone operations.
The SnapCenter cmdlet help and the cmdlet reference information contain detailed information about
PowerShell cmdlets.

SnapCenter Software Cmdlet Reference Guide.

Restore and recover a manually added resource backup

You can use SnapCenter to restore and recover data from one or more backups.

Before you begin

* You must have backed up the resource or resource groups.

* You must have canceled any backup operation that is currently in progress for the resource or resource
group that you want to restore.

* For pre restore, post restore, mount, and unmount commands, you should check if the commands exist in
the command list available on the plug-in host from the following paths:

o For Windows: C:\Program Files\NetApp\SnapCenter\Snapcenter Plug-in
Creator\etc\allowed_commands.config

o For Linux: /opt/snapcenter/scc/etc/allowed _commands.config

@ If the commands do not exist in the command list, then the operation will fail.

About this task

* File-based backup copies cannot be restored from SnapCenter.

 After upgrading to SnapCenter 4.3, the backups taken in SnapCenter 4.2 can be restored but cannot be
recovered. You must use HANA studio or HANA recovery scripts external to SnapCenter to recover the
backups taken in SnapCenter 4.2.

Steps
1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.

2. In the Resources page, filter resources from the View drop-down list based on resource type.

The resources are displayed along with type, host, associated resource groups and policies, and status.
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@ Although a backup might be for a resource group, when you restore, you must select the
individual resources you want to restore.

If the resource is not protected, “Not protected” is displayed in the Overall Status column. This can mean
either that the resource is not protected, or that the resource was backed up by a different user.

Select the resource, or select a resource group and then select a resource in that group.
The resource topology page is displayed.

From the Manage Copies view, select Backups either from the primary or secondary (mirrored or vaulted)
storage systems.

In the Primary backup(s) table, select the backup that you want to restore from, and then click “ .

Primary Backupi(s)
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In the Restore Scope page, select either Complete Resource or File Level.

a. If you select Complete Resource, all of the configured data volumes of the SAP HANA database are
restored.

If the resource contains volumes or gtrees, the Snapshot copies taken after the Snapshot copy
selected for restore on such volumes or qtrees are deleted and cannot be recovered. Also, if any other
resource is hosted on same volumes or gtrees, then that resource is also deleted.

b. If you select File Level, then you can either select All or select the specific volumes or gtrees, and then
enter the path related to those volumes or gtrees, separated by commas

= You can select multiple volumes and qgtrees.

= If the resource type is LUN, the entire LUN is restored.

You can select multiple LUNSs.
@ If you select All, all the files on the volumes, gtrees, or LUNs are restored.

In the Pre ops page, enter pre restore and unmount commands to run before performing a restore job.
Unmount commands are not available for auto discovered resources.

In the Post ops page, enter mount and post restore commands to run after performing a restore job.
Mount commands are not available for auto discovered resources.

In the Notification page, from the Email preference drop-down list, select the scenarios in which you want
to send the emails.

You must also specify the sender and receiver email addresses and the subject of the email. SMTP must



also be configured on the Settings > Global Settings page.

10. Review the summary, and then click Finish.

11. Monitor the operation progress by clicking Monitor > Jobs.

Restore and recover an auto discovered database backup
You can use SnapCenter to restore and recover data from one or more backups.

Before you begin

* You must have backed up the resource or resource groups.

* You must have canceled any backup operation that is currently in progress for the resource or resource
group that you want to restore.

* For pre restore, post restore, mount, and unmount commands, you should check if the commands exist in
the command list available on the plug-in host from the following paths:

o For Windows: C:\Program Files\NetApp\SnapCenter\Snapcenter Plug-in
Creator\etc\allowed_commands.config

o For Linux: /opt/snapcenter/scc/etc/allowed_commands.config

@ If the commands do not exist in the command list, then the operation will fail.

About this task
* File-based backup copies cannot be restored from SnapCenter.

 After upgrading to SnapCenter 4.3, the backups taken in SnapCenter 4.2 can be restored but cannot be
recovered. You must use HANA studio or HANA recovery scripts external to SnapCenter to recover the
backups taken in SnapCenter 4.2.

Steps
1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.

2. In the Resources page, filter resources from the View drop-down list based on resource type.

The resources are displayed along with type, host, associated resource groups and policies, and status.

@ Although a backup might be for a resource group, when you restore, you must select the
individual resources you want to restore.

If the resource is not protected, “Not protected” is displayed in the Overall Status column. This can mean
either that the resource is not protected, or that the resource was backed up by a different user.

3. Select the resource, or select a resource group and then select a resource in that group.
The resource topology page is displayed.

4. From the Manage Copies view, select Backups either from the primary or secondary (mirrored or vaulted)
storage systems.

In the Primary backup(s) table, select the backup that you want to restore from, and then click “ .
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In the Restore Scope page, select Complete Resource to restore the configured data volumes of the SAP
HANA database.

@ You can select either Complete Resource (with or without Volume Revert), or Tenant
Database.

Recovery operation is not supported by SnapCenter Server for multiple tenants when user selects either
the Tenant Database or Complete Restore option. You must use HANA studio or HANA python script to
perform the recovery operation.

a. Select Volume Revert if you want to restore the entire volume.
This option is available for backups taken in SnapCenter 4.3 in NFS environments.
If the resource contains volumes or gtrees, the Snapshot copies taken after the Snapshot copy
selected for restore on such volumes or gtrees are deleted and cannot be recovered. Also, if any other
resource is hosted on the same volumes or gtrees, then that resource is also deleted. This is applicable
when Complete Resource with Volume Revert option is selected for restore.

b. Select Tenant Database.
This option is available only for MDC resources.

Ensure to stop the tenant database before performing the restore operation.

If you select Tenant Database option, you must use HANA studio or use HANA recovery scripts
external to SnapCenter to perform recovery operation.

In the Recovery scope page, select one of the following options:

If you... Do this...

Want to recover as close as possible to the current  Select Recover to most recent state. For single
time container resources specify one or more log and
catalog backup locations.

For multitenant database container (MDC)
resources specify one or more log backup locations
and the backup catalog location.

For MDC resources, the path should contain both
system database and tenant database logs.



If you... Do this...

Want to recover to the specified point in time Select Recover to point in time.
a. Select the time zone.
Browser timezone is populated by default.

The selected time zone along with the input time
is converted to absolute GMT.

b. Enter date and time. For example, the HANA
Linux host is located in Sunnyvale, CA and the
user in Raleigh, NC is recovering the logs in to
SnapCenter.

The time difference between both these
locations is 3 hours, and since the user has
logged in from Raleigh, NC, the default browser
time zone that will be selected in the GUI is
GMT-04:00.

If the user wants to perform a recovery to 5 a.m
.Sunnyvale, CA, then the user has to set the
browser time zone to the HANA Linux host time
zone, which is GMT-07:00 and specify the date
and time as 5:00 a.m.

For single container resources specify one or
more log and catalog backup locations.

For MDC resources, specify one or more log
backup locations and the backup catalog
location.

For MDC resources, the path should contain
both system database and tenant database

logs.
Want to recover to a specific data backup Select Recover to specified data backup.
Do not want to recover Select No recovery. You must perform the recovery

operation manually from the HANA studio.

You can recover only those backups that are taken after upgrading to SnapCenter 4.3, provided both the
host and the plug-in are upgraded to SnapCenter 4.3, and the backups selected for restore are taken after
the resource is converted or discovered as auto discovered resource.

8. In the Pre ops page, enter pre restore and unmount commands to run before performing a restore job.

Unmount commands are not available for auto discovered resources.

9. In the Post ops page, enter mount and post restore commands to run after performing a restore job.
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Mount commands are not available for auto discovered resources.

10. In the Notification page, from the Email preference drop-down list, select the scenarios in which you want
to send the emails.

You must also specify the sender and receiver email addresses and the subject of the email. SMTP must
also be configured on the Settings > Global Settings page.

11. Review the summary, and then click Finish.
12. Monitor the operation progress by clicking Monitor > Jobs.
Restore SAP HANA database using PowerShell cmdlets

Restoring a SAP HANA database backup includes initiating a connection session with the
SnapCenter Server, listing the backups and retrieving backup information, and restoring a
backup.

Before you begin
You must have prepared the PowerShell environment to execute the PowerShell cmdlets.

Steps

1. Initiate a connection session with the SnapCenter Server for a specified user by using the Open-
SmConnection cmdlet.

Open-smconnection -SMSbaseurl https:\\snapctr.demo.netapp.com:8146/
2. Identify the backup that you want to restore by using the Get-SmBackup and Get-SmBackupReport
cmdlets.

This example shows that there are two backups available for the restore:

PS C:\> Get-SmBackup

BackupId BackupName BackupTime
BackupType
1 Payroll Dataset vise-f6 08... 8/4/2015 11:02:32 AM
Full Backup
2 Payroll Dataset vise-f6 08... 8/4/2015 11:23:17 AM

This example displays detailed information about the backup from January 29th 2015 to February 3rd,
2015:
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PS C:\> Get-SmBackupReport -FromDateTime "1/29/2015" -ToDateTime

VerificationStatus

SmBackupId

SmJobId
StartDateTime
EndDateTime
Duration
CreatedDateTime
Status
ProtectionGroupName
SmProtectionGroupId
PolicyName
SmPolicyId
BackupName
VerificationStatus

"2/3/2015"

SmBackupId : 113
SmJobId 2032
StartDateTime 2/2/2015 6:57:03 AM
EndDateTime 2/2/2015 6:57:11 AM
Duration 00:00:07.3060000
CreatedDateTime 2/2/2015 6:57:23 AM
Status Completed
ProtectionGroupName Clone
SmProtectionGroupId 34
PolicyName Vault
SmPolicyId 18
BackupName Clone SCSPR0019366001 02-02-2015 06.57.08

NotVerified

114

2183

2/2/2015 1:02:41 PM
2/2/2015 1:02:38 PM
-00:00:03.2300000
2/2/2015 1:02:53 PM
Completed

Clone

34

Vault

18

Clone SCSPR0019366001 02-02-2015 13.02.45
NotVerified

3. Start the recovery process in the HANA studio.
The database is shut down.

4. Restore data from the backup by using the Restore-SmBackup cmdlet.

AppObjectld is "Host\Plugin\UID", where UID = SID is for single container type resource and
@ UID = MDC\SID is for multiple containers resource. You can get the ResourcelD from the
Get-smResources cmdlet.

Get-smResources -HostName cn24.sccore.test.com -PluginCode HANA

This example shows how to restore the database from the primary storage:

67



Restore-SmBackup -PluginCode HANA -AppObjectId
cn24.sccore.test.com\hana\H10 -BackupId 3

This example shows how to restore the database from the secondary storage:

Restore-SmBackup -PluginCode 'HANA' -AppObjectId
cn24.sccore.test.com\hana\H10 -BackupId 399 -Confirm:$false -Archive @ (
@{"Primary"="<Primary Vserver>:<PrimaryVolume>";"Secondary"="<Secondary
Vserver>:<SecondaryVolume>"})

The backups will be available in HANA studio for recovery.

The information regarding the parameters that can be used with the cmdlet and their descriptions can be
obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter Software
Cmdlet Reference Guide.

Restore resources using PowerShell cmdlets

Restoring a resource backup includes initiating a connection session with the SnapCenter
Server, listing the backups and retrieving backup information, and restoring a backup.

You must have prepared the PowerShell environment to execute the PowerShell cmdlets.

Steps

1. Initiate a connection session with the SnapCenter Server for a specified user by using the Open-
SmConnection cmdlet.

Open-smconnection -SMSbaseurl https:\\snapctr.demo.netapp.com:8146/
2. Retrieve the information about the one or more backups that you want to restore by using the Get-
SmBackup and Get-SmBackupReport cmdlets.

This example displays information about all available backups:

C:\PS>PS C:\> Get-SmBackup

BackupId BackupName BackupTime
BackupType

1 Payroll Dataset vise-f6 08... 8/4/2015 11:02:32 AM
Full Backup

2 Payroll Dataset vise-f6 08... 8/4/2015 11:23:17 AM
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This example displays detailed information about the backup from January 29th 2015 to February 3rd,
2015:

PS C:\> Get-SmBackupReport -FromDateTime "1/29/2015" -ToDateTime

VerificationStatus

"2/3/2015"
SmBackupId 113
SmJobId 2032
StartDateTime 2/2/2015 6:57:03 AM
EndDateTime 2/2/2015 6:57:11 AM
Duration 00:00:07.3060000
CreatedDateTime 2/2/2015 6:57:23 AM
Status Completed
ProtectionGroupName Clone
SmProtectionGroupId 34
PolicyName Vault
SmPolicyId 18
BackupName Clone SCSPR0019366001 02-02-2015 06.57.08

NotVerified

SmBackupId 114

SmJobId 2183

StartDateTime 2/2/2015 1:02:41 PM
EndDateTime 2/2/2015 1:02:38 PM
Duration -00:00:03.2300000
CreatedDateTime 2/2/2015 1:02:53 PM
Status Completed
ProtectionGroupName Clone
SmProtectionGroupld 34

PolicyName Vault

SmPolicyId 18

BackupName Clone SCSPR0019366001 02-02-2015 13.02.45

VerificationStatus

NotVerified

3. Restore data from the backup by using the Restore-SmBackup cmdlet.
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Restore-SmBackup -PluginCode 'DummyPlugin' -AppObjectId
'scch54.sccore.test.com\DummyPlugin\NTP\DB1' -BackupId 269
-Confirm:S$false

output:

Name : Restore
'scch54.sccore.test.com\DummyPlugin\NTP\DB1"

Id : 2368
StartTime : 10/4/2016 11:22:02 PM
EndTime

IsCancellable : False
IsRestartable : False
IsCompleted : False
IsVisible : True
IsScheduled : False
PercentageCompleted : 0
Description

Status : Queued
Owner

Error

Priority : None
Tasks : {1
ParentJobID : 0
EventId : 0
JobTypeId

ApisJobKey

ObjectId : 0
PluginCode : NONE
PluginName

The information regarding the parameters that can be used with the cmdlet and their descriptions can be
obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter Software
Cmdlet Reference Guide.

Monitor SAP HANA databases restore operations

You can monitor the progress of different SnapCenter restore operations by using the
Jobs page. You might want to check the progress of an operation to determine when it is
complete or if there is an issue.

About this task

Post-restore states describe the conditions of the resource after a restore operation and any further restore
actions that you can take.

The following icons appear on the Jobs page, and indicate the state of the operation:

In progress
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. Completed successfully

e x Failed

Completed with warnings or could not start due to warnings

* 9 Queued

@ Canceled

Steps
1. In the left navigation pane, click Monitor.

2. In the Monitor page, click Jobs.

3. In the Jobs page, perform the following steps:
a. Click ﬂ to filter the list so that only restore operations are listed.
b. Specify the start and end dates.
c. From the Type drop-down list, select Restore.

d. From the Status drop-down list, select the restore status.

0]

. Click Apply to view the operations that have been completed successfully.
4. Select the restore job, and then click Details to view the job details.

5. In the Job Details page, click View logs.

The View logs button displays the detailed logs for the selected operation.

After the volume based restore operation, the backup metadata is deleted from the
SnapCenter repository but the backup catalog entries remain in SAP HANA catalog. Though

@ the restore job status displays , you should click on job details to see the warning sign of
some of the child tasks. Click on the warning sign and delete the indicated backup catalog
entries.

Clone SAP HANA resource backups

Clone workflow
The clone workflow includes performing the clone operation and monitoring the operation.

About this task
* You can clone on the source SAP HANA server.

* You might clone resource backups for the following reasons:

o To test functionality that has to be implemented using the current resource structure and content during
application development cycles

> For data extraction and manipulation tools when populating data warehouses

o To recover data that was mistakenly deleted or changed

The following workflow shows the sequence in which you must perform the clone operation:
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Define a clone strategy. ﬂj

Clone the backup.

|

Monitor the clone operation.

:

If required, split the clone.

You can also use PowerShell cmdlets manually or in scripts to perform backup, restore, and clone operations.
The SnapCenter cmdlet help and the cmdlet reference information contain detailed information about
PowerShell cmdlets.

Clone a SAP HANA database backup

You can use SnapCenter to clone a backup. You can clone from primary or secondary
backup.

Before you begin
* You should have backed up the resources or resource group.

* You should ensure that the aggregates hosting the volumes should be in the assigned aggregates list of
the storage virtual machine (SVM).

* You cannot clone file-based backups.

* The target clone server should have the same SAP HANA instance SID that is provided in the Target Clone
SID field.

* For pre clone or post clone commands, you should check if the commands exist in the command list
available on the plug-in host from the following paths:

o For Windows: C:\Program Files\NetApp\SnapCenter\Snapcenter Plug-in
Creator\etc\allowed _commands.config.

o For Linux: /opt/snapcenter/scc/etc/allowed_commands.config.

@ If the commands do not exist in the command list, then the operation will fail.

About this task
For information about clone split operation limitations, see ONTAP 9 Logical Storage Management Guide.

Steps
1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.

2. In the Resources page, filter resources from the View drop-down list based on resource type.

The resources are displayed along with information such as type, host, associated resource groups and
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policies, and status.

3. Select the resource or resource group.

You must select a resource if you select a resource group.

The resource or resource group topology page is displayed.

4. From the Manage Copies view, select Backups either from the primary or secondary (mirrored or vaulted)

storage systems.

5.
Select the data backup from the table, and then click ' )

6. In the Location page, perform the following actions:

For this field...
Plug-in host

Target Clone SID

NFS Export IP Address

iSCSI Initiator

Protocol

Do this...

Select the host on which the clone should be
mounted and the plug-in is installed.

Enter the SAP HANA instance ID to clone from the
existing backups.

Enter IP addresses or the host names on which the
cloned volumes will be exported.

Enter iSCSI initiator name of the host to which the
LUNSs are exported. This option is available only if
you selected LUN resource type.

Enter the LUN protocol. This option is available only
if you selected LUN resource type.

If the resource selected is a LUN and you are cloning from a secondary backup, then the destination
volumes are listed. A single source can have multiple destination volumes.

@ Before cloning, you must ensure that the iSCSI initiator or the FCP is present and are
configured and logged into alternate hosts.

7. In the Scripts page, perform the following steps:

@ The scripts are run on the plug-in host.

a. Enter the commands for pre clone or post clone that should be run before or after the clone operation,

respectively.

= Pre clone command: delete existing databases with the same name

= Post clone command: verify a database or start a database.

b. Enter the mount command to mount a file system to a host.

Mount command for a volume or gtree on a Linux machine:
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Example for NFS:
mount VSERVER DATA IP:3%VOLUME NAME Clone /mnt
8. In the Notification page, from the Email preference drop-down list, select the scenarios in which you want

to send the emails.

You must also specify the sender and receiver email addresses, and the subject of the email.

9. Review the summary, and then click Finish.

10. Monitor the operation progress by clicking Monitor > Jobs.

Clone SAP HANA database backups using PowerShell cmdlets

The clone workflow includes planning, performing the clone operation, and monitoring the
operation.

You must have prepared the PowerShell environment to execute the PowerShell cmdlets.

The information regarding the parameters that can be used with the cmdlet and their descriptions can be
obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter Software
Cmdlet Reference Guide.

Steps

1. Initiate a connection session with the SnapCenter Server for a specified user by using the Open-
SmConnection cmdlet.

Open-SmConnection -SMSbaseurl https:\\snapctr.demo.netapp.com:8146/

2. Retrieve the backups to perform the clone operation by using the Get-SmBackup cmdlet.

This example shows that two backups are available for cloning:

C:\PS> Get-SmBackup

BackupId BackupName
BackupTime BackupType
1 Payroll Dataset vise-f6 08... 8/4/2015
11:02:32 AM Full Backup
2 Payroll Dataset vise-f6 08... 8/4/2015

11:23:17 AM

3. Initiate a clone operation from an existing backup and specify the NFS export IP addresses on which the
cloned volumes are exported.
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This example shows that the backup to be cloned has an NFSExportlPs address of 10.232.206.169:

New-SmClone -AppPluginCode hana -BackupName

scsccorel sccore test com hana H73 scsccorel 06-07-2017 02.54.29.3817
—-Resources @{"Host"="scsccorel.sccore.test.com";"Uid"="H73"}
-CloneToInstance shivsccéd.sccore.test.com -mountcommand 'mount
10.232.206.169:%hana73data Clone /hana83data' -preclonecreatecommands
'/home/scripts/scpre clone.sh' -postclonecreatecommands
'/home/scripts/scpost clone.sh'

@ If NFSExportIPs is not specified, the default is exported to the clone target host.

4. Verify that the backups were cloned successfully by using the Get-SmCloneReport cmdlet to view the clone
job details.

You can view details such as clone ID, start date and time, end date and time.

PS C:\> Get-SmCloneReport -JobId 186

SmCloneId 1

SmJobId 186

StartDateTime 8/3/2015 2:43:02 PM
EndDateTime 8/3/2015 2:44:08 PM
Duration 00:01:06.6760000
Status Completed
ProtectionGroupName Draper

SmProtectionGroupId : 4

PolicyName OnDemand Clone

SmPolicyId : 4

BackupPolicyName OnDemand Full Log

SmBackupPolicyId 1

CloneHostName SCSPR0O054212005.mycompany .com

CloneHostId H

CloneName Draper clone 08-03-2015 14.43.53

SourceResources {Don, Betty, Bobby, Sally}

ClonedResources {Don DRAPER, Betty DRAPER, Bobby DRAPER,
Sally DRAPER}

SmJobError

Monitor SAP HANA database clone operations

You can monitor the progress of SnapCenter clone operations by using the Jobs page.
You might want to check the progress of an operation to determine when it is complete or
if there is an issue.

75



About this task
The following icons appear on the Jobs page, and indicate the state of the operation:

In progress
. Completed successfully
* x Failed

Completed with warnings or could not start due to warnings
* D Queued
e @ Canceled

Steps

—_

. In the left navigation pane, click Monitor.

N

. In the Monitor page, click Jobs.

w

. In the Jobs page, perform the following steps:
a. Click ﬂ to filter the list so that only clone operations are listed.
b. Specify the start and end dates.
c. From the Type drop-down list, select Clone.

d. From the Status drop-down list, select the clone status.

0]

. Click Apply to view the operations that are completed successfully.

N

. Select the clone job, and then click Details to view the job details.

)]

. In the Job Details page, click View logs.

Split a clone

You can use SnapCenter to split a cloned resource from the parent resource. The clone
that is split becomes independent of the parent resource.

About this task
* You cannot perform the clone split operation on an intermediate clone.

For example, after you create clone1 from a database backup, you can create a backup of clone1, and
then clone this backup (clone2). After you create clone2, clone1 is an intermediate clone, and you cannot
perform the clone split operation on clone1. However, you can perform the clone split operation on clone2.

After splitting clone2, you can perform the clone split operation on clone1 because clone1 is no longer the
intermediate clone.

* When you split a clone, the backup copies and clone jobs of the clone are deleted.
* For information about clone split operation limitations, see ONTAP 9 Logical Storage Management Guide.

» Ensure that the volume or aggregate on the storage system is online.

Steps
1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
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2. In the Resources page, select the appropriate option from the View list:

Option Description
For database applications Select Database from the View list.
For file systems Select Path from the View list.

3. Select the appropriate resource from the list.
The resource topology page is displayed.

4. From the Manage Copies view, select the cloned resource (for example, the database or LUN), and then
click . -

5. Review the estimated size of the clone that is to be split and the required space available on the aggregate,
and then click Start.

6. Monitor the operation progress by clicking Monitor > Jobs.

The clone split operation stops responding if the SMCore service restarts. You should run the Stop-SmJob
cmdlet to stop the clone split operation, and then retry the clone split operation.

If you want a longer poll time or shorter poll time to check whether the clone is split or not, you can change
the value of CloneSplitStatusCheckPollTime parameter in SMCoreServiceHost.exe.config file to set the
time interval for SMCore to poll for the status of the clone split operation. The value is in milliseconds and
the default value is 5 minutes.

For example:
<add key="CloneSplitStatusCheckPollTime" wvalue="300000" />

The clone split start operation fails if backup, restore, or another clone split is in progress. You should
restart the clone split operation only after the running operations are complete.

Related information
SnapCenter clone or verification fails with aggregate does not exist

Delete or split SAP HANA database clones after upgrading SnapCenter

After upgrading to SnapCenter 4.3, you will no longer see the clones. You can delete the
clone or split the clones from the Topology page of the resource from which the clones
were created.

About this task

If you want to locate the storage footprint of the hidden clones, run the following command: Get-SmClone
-ListStorageFootprint

Steps
1. Delete the backups of the cloned resources by using the remove-smbackup cmdlet.
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Delete the resource group of the cloned resources by using the remove-smresourcegroup cmdlet.

3. Remove the protection of the cloned resource by using the remove-smprotectresource cmdlet.

Select the parent resource from the Resources page.

The resource topology page is displayed.

. From the Manage Copies view, select the clones either from the primary or secondary (mirrored or

replicated) storage systems.

Select the clones, and then click Jj to delete clones or click . to split the clones.

7. Click OK.
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